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Introduction

Welcome to the CA and CB Series of PC/104 communication modules, a multiport serial module for industrial
applications. It is designed for the PC/104 CPU and PC/104-Plus boards that respectively accept the PC/104
and PC/104-Plus expansion interface. Optional DB9 and DB25 cables are available to connect different devices.

The CA Series includes the following models:

CA-108: 8 ports, RS-232

CA-108-T: 8 ports, RS-232, wide temperature

CA-114: 4 ports, RS-232/422/485

CA-114-T: 4 ports, RS-232/422/485, wide temperature

CA-1341I: 4 ports, RS-422/485, optical isolation protection

CA-134I-T: 4 ports, RS-422/485, optical isolation protection, wide temperature
CA-104: 4 ports, RS-232

CA-104-T: 4 ports, RS-232, wide temperature

CA-132: 2 ports, RS-422/485

CA-132-T: 2 ports, RS-422/485, wide temperature

CA-132I: 2 ports, RS-422/485, optical isolation protection

CA-132I-T: 2 ports, RS-422/485, optical isolation protection, wide temperature

The CB Series includes the following models:

CB-108: 8 ports, RS-232

CB-108-T: 8 ports, RS-232, wide temperature

CB-114: 4 ports, RS-232/422/485

CB-114-T: 4 ports, RS-232/422/485, wide temperature

CB-1341I: 4 ports, RS-422/485, optical isolation protection

Cb-134I-T: 4 ports, RS-422/485, optical isolation protection, wide temperature

2 kV optical isolation is provided on optical isolation models. Wide-temperature models are rated for operation
between -40 to 85°C.

The following topics are covered in this chapter:

O Overview
O Package Checklist

O Product Specifications
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Overview

The PC/104 standard serial boards are very popular for embedded applications. Moxa offers a wide selection of
PC/104 and PC/104-Plus serial boards to provide industrial-grade connections to multiple serial devices.

Use Moxa's serial boards so that your PC/104-based systems can establish serial device connections with high
data throughput over multiple serial interfaces. The CA serial board series is for PC/104 modules, while the CB
serial board series is for PC/104-Plus modules.

Package Checklist

MOXA performs a careful mechanical and electrical inspection of each module prior to shipping. Your module
should arrive in perfect electrical order, free of any marks or scratches. Please handle the module by the edges
only, since your body'’s static charge can damage the integrated circuits. When the module is not in use, please
keep it in the anti-static package provided. You may also use this package to return the module if it requires
repair.

The CA/CB Series module is shipped with the following items:
e Multiport serial module (PC/104 is for CA Series; PC/104-Plus is for CB Series)
e Documentation and software CD

e Quick installation guide

e 5-year product warranty statement

NOTE

Please notify your sales representative if any of the above items are missing or damaged.

The CA Series module features the following:

e Two, four, or eight serial ports (depending on the model)

e RS-232, RS-422, or RS-485 operation (depending on the model)
e 64-byte FIFOs and on-chip flow control

e Up to 921.6Kbps data transmission speed

e Built-in 15 KV ESD protection

e Configurable IRQ and I/0O settings

e Onboard Tx, Rx LED indicators for each port

e Optional wide temperature support (-40 to 85°C)

The CB Series module features the following:

e Four or eight serial ports (depending on the model)

e RS-232, RS-422, or RS-485 operation (depending on the model)
e 128-byte FIFOs and on-chip flow control

e Up to 921.6Kbps data transmission speed

e Built-in 15 KV ESD protection

e Onboard Tx, Rx LED indicators for each port

e Optional wide temperature support (-40 to 85°C)

1-2
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Product Specifications

CA Series PC/104 Multiport Serial Module

Hardware
I/0 controller
Connector Type

Interface
Bus
No. of Ports

Max. No. of Modules

Signals
RS-232
RS-422
4-wire RS-485
2-wire RS-485

Performance
Baudrate

Configuration
Parity

Data Bits

Stop Bit(s)

IRQ

FIFO
Additional Settings
Driver Support

Power and Environment
Operating Temperature

Operating Humidity
Storage Temperature
ESD Protection

Other
Dimensions (W x D)

Regulatory Approvals

Warranty

16C550C or compatible
40-pin box header (CA-108, CA-114, CA-134I, CA-104)
20-pin box header (CA-132 , CA-132I)

PC/104 bus (Ver. 2.4)

2 ports (CA-132 , CA-132I)

4 ports (CA-114, CA-1341, CA-104 )
8 ports (CA-108)

8

TxD, RxD, RTS, CTS, DTR, DSR, DCD, GND
TxD+(B), TxD-(A), RxD+(B), RxD-(A), GND
TxD+(B), TxD-(A), RxD+(B), RxD-(A), GND
Data+(B), Data-(A), GND

50 bps to 921.6 Kbps (supports nonstandard baud rates)

None, Even, Odd, Space, Mark

56,7,8

1,1.5,2

Shared IRQ for all ports

(includes IRQ 3, 4, 5, 6, 7,9, 10, 11, 12, 15)

64 bytes

I/0 base address, interrupt vector, serial interface (all by DIP switch)
DOS

Windows 2000/XP/2003/Vista/2008/7/8/8.1/10 (x86/x64), Windows
Server 2008 R2/2012/2012 R2/2016 (x64)

Linux 2.4, Linux 2.6

Standard models: 0 to 55°C (32 to 131°F)
“-T” models:, -40 to 85°C (-40 to 185°F)
5 to 95% RH

-40 to 70°C (-40 to 158°F)

Embedded 15 KV ESD protection

96 x 90 mm

EN55022 Class A, EN55024, EN6100-3-2, EN61000-3-3, FCC Part 15
Class A

5 years

1-3
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CB Series PC/104-Plus Multiport Serial Module

Hardware

I/0O controller
Connector Type
Interface

Bus

No. of Ports

Max. No. of Modules
Signals

RS-232

RS-422

4-wire RS-485
2-wire RS-485
Performance
Baudrate

Configuration
Parity

Data Bits

Stop Bit(s)

IRQ

FIFO

Additional Settings
Driver Support

Power and Environment
Operating Temperature

Operating Humidity
Storage Temperature
ESD Protection
Other

Dimensions (W x D)
Regulatory Approvals

Warranty

MU860 (16C550C compatible)
40-pin box header

PC/104-Plus (PCI) bus

4 ports (CB-114, CB-134I)
8 ports (CB-108)

8

TxD, RxD, RTS, CTS, DTR, DSR, DCD, GND
TxD+(B), TxD-(A), RxD+(B), RxD-(A), GND
TxD+(B), TxD-(A), RxD+(B), RxD-(A), GND
Data+(B), Data-(A), GND

50 bps to 921.6 Kbps
(supports nonstandard baud rates)

None, Even, Odd, Space, Mark
56,7,8

1,1.5,2

BIOS assigned

128 bytes

Serial interface selection by DIP switch
DOS

Windows 2000/XP/2003/Vista/2008/7/8/8.1/10 (x86/x64),

Windows Server 2008 R2/2012/2012 R2/2016 (x64)
Linux 2.4, Linux 2.6 (x86 and x64)

Standard models: 0 to 55°C (32 to 131°F)
“-T” models:, -40 to 85°C (-40 to 185°F)
5 to 95% RH

-40 to 70°C (-40 to 158°F)

Embedded 15 KV ESD protection

96 x 90 mm

EN55022 Class A, EN55024, EN6100-3-2,
EN61000-3-3, FCC Part 15 Class A

5 years
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Hardware Installation

This chapter explains how to install the CA/CB Series multiport serial module.
The following topics are covered in this chapter:

O Hardware Installation
O Block Diagrams
» I/0 Base Address (For CA Series)
» Rotary Switch(For CB Series)
» Termination Resistor
» Interrupt Vector for CA Series

O Serial Interface
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Hardware Installation

Installing the CA/CB Series module is easy. For the CA Series, before inserting the module into the PC/104 slot,
you must first configure the I/O base address, interrupt vector, IRQ, and serial interface (for select models).

ATTENTION

Safety First!
To prevent damage to your system or board, make sure your embedded PC’s power is turned off before
installing your CA/CB Series module.

A

CA Series CB Series

Step 1: Shut off power to your embedded PC and Step 1: Shut off power to your embedded PC
to any peripheral devices. After shutting and to any peripheral devices. After
off power, remove the cover of your shutting off power, remove the cover
embedded PC. of your embedded PC.

Step 2: Use the DIP switches on the module to Step 2: Use the DIP switches on the module
select the I/0 base address, interrupt to select the serial interface. Details
vector, IRQ, and serial interface (for for each model are provided later in
select models). Details for each model this chapter.
are provided later in this chapter. Step 3: Insert the module firmly into the

Step 3: Insert the module firmly into the embedded PC’s PC/104-Plus slot.
embedded PC’s PC/104 slot. Step 4: Screw the control board in place.

Step 4: Screw the control board in place Step 5: Connect the cables.

Step 5: Connect the cables. Step 6: Power on the embedded PC. The

Step 6: Power on the embedded PC. BIOS will automatically set the IRQ

and I/O address.
Step 7: Proceed with the software
installation. Please refer to Chapter 3.

Block Diagrams

CA-108

IIl.I_|

2-2

PC/104 Slot

SW2: Interrupt Vector
SW1: I/0 Base Address

i— Box Header Connector (Ports 1 to 4)

Box Header Connector (Ports 5 to 8)
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CA-114

CIChE

]
1111

CA-1341, CA-132 , CA-1321

u
I
g ocss

NN

CA-104

SW3

SW4 ] Serial Interface
SW5

SW1: I/0 Base Address
SW2: Interrupt Vector
PC/104 Slot

Box Header Connector

RS-422/RS-485

@) @———— > \WIRE/4- WIRE

SW1: I/0O Base Address

SW2: Interrupt Vector

PC/104 Slot

Box Header Connector
20-pin for CA-132 V2, CA-1321 V2
40-pin for CA-134l

SW2: Interrupt Vector

it

SW1: 1/O Base Address

i— Box Header Connector

PC/104 Slot

2-3
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CB-108

Rotary Switch
PC/104-Plus Slot

Box Header Connector (Ports 1 to 4)
Box Header Connector (Ports 5 to 8)

PC/104 Slot

CB-114

Rotary switch

PC/104-Plus Slot

SWA1

— SW2 ] Serial Interface
JP 3 SWS

Box Header Connector
PC/104 Slot

CB-1341

Rotary Switch
PC/104-Pius Slot
RS422/485

2-wire/4-wire

Box Header Connector
PC/104 Slot

I/0 Base Address (For CA Series)

Use DIP switch SW1 to set port 1’s I/O base address. The other ports will be configured automatically. The
default I/O base address is 0x180 and allows settings from 0x000 to 0x3FF. Some popular settings are
provided below:

A3 A4 A5 A6 A7 A8 A9

8 1 2 4 8 1 2 Hex
ON ON ON ON ON ON ON 0x000
ON ON ON ON ON ON off 0x200
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ON ON ON ON ON off off 0x300
ON ON ON ON off off off 0x380
ON ON ON off off off off 0x3C0
ON ON off off off off off 0x3EO0
ON off off off off off off 0x3F0
off off off off off off off 0x3F8
off ON ON ON ON ON ON 0x008
off off ON ON ON ON ON 0x018
off off off ON ON ON ON 0x038
off off off off ON ON ON 0x078
off off off off off ON ON 0xO0F8
off off off off off ON off 0x2F8

For example, an I/O base address of 0x180 should be set as follows:

A3 A4 A5 A6 A7 A8 A9 Hex
ON ON ON ON off off ON 0x180
A3 A4 A5 A6 A7 A8 A9

¢ DIP

i a]alal®*la

112 3 4 5|6 7

0 8 1 E:on,g=off

The other serial ports will be set automatically to 0x188, 0x190, 0x198, etc.

Rotary Switch(For CB Series)

A rotary switch on the board makes it easy to set the appropriate signals, particularly when installing multiple
PC/104-Plus modules in the same unit. The rotary switch, which looks like a clock, provides a bidirectional path
with no signal propagation delay. The first module on the stack should be set to CLKO, the second to CLK1, etc.,
to eliminate clock skew between modules.

Termination Resistor

Onboard termination resistors can be activated individually for each serial port using jumpers. With regard to
the CA Series: for CA-114 and CA-134I, use JP1 through JP4; for CA-132 and CA-132I, use JP1 and JP2. JP1
corresponds to serial port 1. For the CB Series, use jumpers JP1 through JP4. JP1 corresponds to serial port 1.
Short the jumper pins to activate the termination resistor; leave the jumper pins open to bypass the
termination resistor.

Interrupt Vector for CA Series

Use DIP switch SW2 to set port 1’s interrupt vector. The default interrupt vector is 0x1C0, with SW2 set as

follows:
A3 A4 A5 A6 A7 A8 A9 Hex
ON ON ON off off off ON 0x1CO

2-5
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A3 A4 A5 A6 A7 A8 A9
¢

aalal"l" " la

112 3 4 5|6 7

0 C 1 E=on,g=off

Serial Interface

CA Series

For the CA-114, use SW3, SW4, and SW5 to select the serial interface as follows:

-hl]i

sSw3

n[ 4

> Port No.

aw 2w
Interface RS-232 RS-422
RS-485 RS-485 N P swa
sw3 - - ON OFF HEH
sw4 - ON OFF OFF 2 4 — PortNo.
SW5 ON OFF OFF OFF I sSW5

~[Hlo||~[Ho||~[Ho
“[lu ‘*‘[lu ‘*‘Elu

~ [ %

INE

[ Port No.

For the CA-1341, CA-132, and CA-132I, use the 2-WIRE/4-WIRE and RS-422/RS-485 DIP switches to select
the serial interface as follows:

Interface 2-WIRE/4-WIRE RS-422/RS-485
RS-422 - OFF
4-wire RS-485 OFF ON
2-wire RS-485 ON ON

CB Series

For the CB-114 and CB-134I, use the DIP switch to select serial interface.

CB-114

Mode S1 S2 S3

RS-232 - - ON

RS-422 - ON OFF
4-wire RS-485 ON OFF OFF
2-wire RS-485 OFF OFF OFF
CB-1341

Mode S1 S2

RS-422 - OFF

4-wire RS-485 OFF ON

2-wire RS-485 ON ON

2-6
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IRQ for CA Series

Before selecting an IRQ, please enter the PC’s BIOS and reserve a dedicated IRQ for the module. On the module,
the IRQ is set by a jumper. Before inserting the module into the PC/104 slot, use the jumper to select an IRQ
(3,4,5,6,7,9, 10, 11, 12, or 15).

2-7
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Software Installation

After installing the CA/CB Series module in your embedded computer, the next step is installing the software.
Drivers for various operating systems are provided, including DOS, Windows, and Linux. This chapter explains
how to install and remove the CA/CB Series driver.

The following topics are covered in this chapter:

O Windows OS

» Older OS for CA Series

» Older OS for CB Series

» Newer OS for Both CA/CB Series
O Non-Windows OS
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Windows OS
Older OS for CA Series

DOS

Moxa DOS API-232 is a software package that can help you develop or debug serial communications programs.
This section will explain how to install the package, set up the driver, and load or unload the driver. For
additional information about the API-232 library and utilities, please refer to Chapter 4.

The DOS drivers support the CA-104, CA-104-T, CA-132, CA-132-T, CA-132I, and CA-132I-T. The CA-108,
CA-114, and CA-134I models are not supported under DOS.

In the following instructions, the CA-104 is used as an example.

Installing the Driver

Run the installation program, DOSINST.EXE, in the DOS folder. Specify the target directory for the API-232
files (e.g., C:\MOXA). Press F2 to start the installation.

N PSS AT B A

FARSHa1H tar i s bal LE S on

When the installation is completed, you will be prompted to set up the board and driver initial values. We
strongly recommendthat you do so.

3-2
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Driver Setup

The following instructions are not intended to illustrate every function of the setup program. For more detailed
information, please refer to the help files by pressing F1 in the setup program.
1. Run the setup program BIN\SETUP.EXE.

2. Select your CA Series model and press Enter.

e

POyl Honaredl Sy

sk e ety

3. You must set the Port No., I/O Address, IRQ, and INT Vector properly. These settings must match your
module’s hardware configuration.

PRS0 Hovearsol S rs e g

e SRk EaExat Pl Dot =

4. Press PgDn to view advanced the port setup options. Your module’s configuration will be displayed along
with other settings, such as port nhumber, buffer size, etc.

3-3
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5. Verify the settings and make any necessary changes.

=3 i i 1) 5

1 A Fhre brop e ot A H F=rn fikort

Port number: This is the port ID of each port. Application software will refer to a port by its port
number (ID). Port numbers must be unique; duplicated port numbers are not
allowed. The port ID can range from 0 to 127 as long as it does not overlap with
another port. Generally, you should consider the convenience of programming
when specifying the port number.

TxD buffer size: This is the transmission (output) buffer allocated in the system for each port.
RxD buffer size: This is the receiving (input) buffer allocated in the system for each port.
F5: Group Edit: This allows you to configure several ports simultaneously as a group.

ik ILE] B

= Ahart

6. Press F10 to save the latest configuration and exit the setup program.
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Loading the Driver

After setting up the driver, you must load the driver in order to gain access to the serial ports on the module.
Run BIN\DPC-DRV.EXE at the DOS prompt. The driver will detect your CA Series module automatically. You
should see messages indicating successful detection of your module, such as the following:

PC/104 Communication Module DOS driver Version 1.0

Setup driver ...

CA-104 series OK!

Device driver setup O.K.

At this point, you can execute applications that support API-232 functions, or start developing applications
using the API-232 library.

Unloading the Driver

To unload or release the CA Series driver from memory, enter DPC-DRV/Q at the DOS prompt.

Windows NT
The Windows NT drivers conform to the Win32 COMM API standard and support the CA-104, CA-104-T, CA-132,

CA-132-T, CA-132I, CA-132I-T. CA-108, CA-114, and CA-134I.
In the following instructions, the CA-104 is used as an example.

Installing the Driver

1. Right-click Network Neighborhood and select Properties in the context menu.

Open
Explore
Eind Computer...

tap Metwork, Drive. ..
Dizconnect Metwark Drive...

Create Shortout
Rename

2. Under the Adapters tab, click Add....
Network [ 2] ]

\dsnt\hcallunl SEIVICESI Frolocols  Adapters IEmdmgsI

Netwol

Add... Bemove Broperties. Update

Itern Mates:
D-Link DFE-530T: PCI Fast Ethemet Adapter [Rew B)

Cancel

3-5
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3. When prompted to select a network adapter, click Have Disk.

Select Network Adapter E |

Click the Metwaork Adapter that matches your hardware, and then

click Q. |f you have an inztallation disk for this component, click
Have Dizk.

Hetwork Adapter:

ACorm 3CHOZ 154 16-bit Ethernet Adapter il
ACam Etherink | Adapter [alza 116 and 16 TR
ACom Etherlink 111 15A/PCHMCIA Adapter
ACom EtkherLink 11l PCl Bus-M azter Adapter [3C530]
3ACom Etherlink16/EtherLink 16 TP Adapter

=
BE® 2 mre C ok el iede DL A0 ANDACE T A d-rbeae FICFEQRT

Have Disk... |

ak. | Cancel |

4. At the prompt, insert the installation disk provided with your module.

Inzert Dizk |
[nzert digk. with zoftware provided by the zoftware or Ok,

\@ hardware manufacturer, | the files can be found at a -
different location, for example on anather drive type a Cancel |
new path to the filez below.

I.ﬁ.:'\windnws.nd

For the location, enter A:\windows.nt. Click OK to continue.
5. Windows will install the drivers.

Setup |
Copying: mxicfg.exe

To: CYMMT S pztem32

3-6
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6. After the files have been installed, a configuration panel will open. Click Add to continue.

= Moxa PC104 Communication Module Configuration Panel

Board Type W2 address | INT vectar | IR | Bus | Dy | COb Mutnbet

Addd EEmEVE | Property |
Ok Cance| |

7. Under Board Type, select your CA Series model. The window will show the COM port numbers that will be
assigned to the CA Series serial ports, as well as other settings. Click OK to continue.

Property

Board Type j
W INT Yectar

CA132] Series
Interrupt Mo, |1 0 j

Baze /0 Port Address 180

Part | COM Mo, | BEx FIFO Trig. | Tx FIFO Size

COM3S

1
2 COhig =] B
3 COMS a6 G4
4 COME =] B
Port Setting
o] Cancel

3-7
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8. The CA Series module will appear as a network adapter. Click OK to complete installation of the module.
Metwork H |
Identificatinnl SErvicesl Protocol:  Adapters | Bindingsl
MNetwark Adapters:

E& 1] D-Link DFE-530T PCI Fast Ethernet Adapter [Fev B
[ , PC104 Communication Module Adapter

Add... Bemove Froperties... pdate

[tem Motes:
kDt PC104 Communication Module Adapter

k. I Cancel

Uninstalling the Module

1. Right-click Network Neighborhood and select Properties in the context menu.

Open
Explore
Eind Computer...

tap Metwork, Drive. ..
Dizconnect Metwark Drive...

Create Shortout
Rename
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2. Under the Adapters tab, select your CA Series module and click Remove.

Metwork
Identificationl Servicesl Protocols  Adapters |Bindings|
Metwork Adapters:

Fﬁﬂ] D-Link DFE-530T% PCI Fast Ethernet Adapter [Rev B)
[9]

'[104 Communication Module &dapter

Add... Hemove Properties... Update

Item Motes:
MO4 PC104 Communication Module ddapter

oK I Cancel |

3. A confirmation dialog will appear. Click OK to uninstall the device.

Waning |

Thiz action will permanently remoyve the companent fram the zuztem.
IF wous wigh ta renztall i, pou will hawve to restart the zustem before daing =a.

Do you still wish to continue?

Windows 95, 98, ME
The Windows 95/98/ME drivers conform to the Win32 COMM API standard and support the CA-104, CA-104-T,

CA-132, CA-132-T, CA-132I, CA-132I-T, CA-108, CA-114, and CA-134I.
In the following instructions, the CA-104 is used as an example.

Installing the Driver

1. Insert the CA Series installation disk and run Setup95.exe through Start menu >Run.

Run E E3

Type the name of a program, folder, docurment, or Intermet
rezource, and \Windows will open it for you.

Open: I.-'l'-.: YSetupd5.ene j

Cancel | Browse... |

|| Start”J 7 e
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2. Click Next to proceed through the Welcome screens.

Moxa PC104 Communication Module Drivers Installation

Welcome!

This installation program is about to install Moxa
Smartio/Industio driver to your system,

Press the Nest button to start the installation. You can
press the Cancel button now if you don't want to proceed
further installation procedure.

Moxa PC104 Communication Module Drivers Installation E3|

Ready to Install!

‘You are now ready to install Moxa PC104 Communication
Module driver.

Press the Nest button to begin the installation or the Back
button to reenter the Update Driver information.

3. Windows will install the drivers. When the installation has been completed, click Finish.

Installing E3

Copwing Moxa PC104 Communication kModule Driver:
AWM 98455 TE M smisizer. vad

Moxa PC104 Communication Module Drivers Installation

Installation Completed!

The Maxa PC104 Communication Module driver hag been
successfully installed.

Press the Finish button to complete installation and enter the
Maoxa PC104 Communication Module driver configuration
panel.
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4. After the files have been installed, a configuration panel will open. Click Add to continue.

s Moxa PC104 Communication Module Configuration Panel

Board Type W2 address | INT vectar | IR | Bus | Dy | COb Mutnbet

Addd EEmEVE | Property |
Ok Cance| |

5. Under Board Type, select your CA Series model. The window will show the COM port numbers that will be
assigned to the CA Series serial ports, as well as other settings. Click OK to continue.

Property

Board Type j
W INT Yectar

CA132] Series
Interrupt Mo, |1 0 j

Baze /0 Port Address 180

Part | COM Mo, | BEx FIFO Trig. | Tx FIFO Size

COM3S

1
2 COhig =] B
3 COMS a6 G4
4 COME =] B
Port Setting
o] Cancel
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6. The CA Series module will now appear in the configuration panel. Click OK to complete installation of the
module.

s Moxa PC104 Communication Module Configuration Panel

Board Type D address | INT vectar | IRGQ | Bus | Dew | COM Mumber

104 Seres “TTTCOMA L COMA.

Retnove | Propetty |

8] Cancel

Open the configuration panel again through Start >Programs ->Moxa Utilities > MOXA PC104
Communication Module Configuration Panel.

Uninstalling the Module

Open the configuration panel through Start>Programs>Moxa Utilities>Moxa PC104 Communication
Module Configuration Panel. Select your CA Series module and click Remove

s Moxa PC104 Communication Module Configuration Panel

Board Type D address | INT vectar | IRGQ | Bus | Dew | COM Mumber

CA104 Series 150 120 - cobdd | COhdd

Retnove | Propetty |
8] | Cancel |

2. A confirmation dialog will appear. Click Yes to uninstall the device.

Configuration Panel |

@ Do you really want ta remave this board 7
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E3 Control Panel Hi=] E3

J File Edit ‘“iew Go Favoites Help |
S — >
= G| ¥
Eack fmriand p Cut Copy Pazte
J-"—“‘-EIEITESS (=] Control Panel j
B = 0 9
: =
Add Hew e BDE Date/Time Diizplay
Hardware Adrinigtrator
A A & oawm
Fants Game [nternet K.epboard Maodems: |
Controllers Options
o ) 8 %\%
Lngil:;m - [ ;
Mouze Multimedia Metwork, QDBC Data Pazswords
Sources [22bil] d

|1 object(z] zelected

|_§‘ by Computer

i

3. To remove the driver from the system, open Add/Remove Programs in the Control Panel.

4. Under the Install/Uninstall tab, select MOXA PC104 Communication Module Driver and click

Add/Remove.

AddfRemove Programz Properties |

Install U ninstall | windows Setup I Startup Digk I

£

To inztall a new program from a floppy dizk or CO-ROM
drive, click [nstall,

Irgtall... I

The following zoftware can be automatically remowved by
YWindows. To remove a program or o modify itz installed
components, select it from the list and click,
Add/Rernove.

o

kicrozoft Jet 4.0 Service Pack 4

b, Intellio Drriver

=00 FC104 Communication Module Diver
R4 Smartiod ndustio Driver

Mera - Burning Rom [wWeb installer]
Partitiontd agic: 5.0

PCornr Lite 2.5

FPCormrm Proter 2.0

Sentinel Spstem Driver

Add/Bemove. .. |

k. Cancel Sl |
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5. A confirmation dialog will appear. Click Yes to remove the driver.

MO=A PC104 Communication Module Driver E

Do you really want to remove bMORS PCT104 Communication kaodule Driver ?

6. After the driver has been removed, click OK to close the window.

MOxA PC104 Communication Module Driver

Remoyve MDA PC104 Communication bodule Driver complete |

Windows CE 5.0

In this section, we explain how to install Moxa CA series boards under WinCE 5.0. These instructions are
intended for users who are familiar with the Windows CE Platform Builder 5.0 ToolKit, and who would like to
install one or more Moxa Tech products. Here, we only give the step-by-step installation instructions for the
development environment. You will need to download the image file to the target host yourself.

The WInCE 5.0 driver for the Moxa CA Series PC/104 Multiport Serial Module supports the following products:
CA Series: CA-108, CA-114, CA-1341I, CA-104, CA-132, and CA-1321.

In the the following steps, we are using CA-104 as an example.

Installing the driver

The following procedure explains how to install the CA-104 multiport serial module driver under WinCE.

1. Obtain a copy of the Moxa Tech WinCE 5.0 driver package and extract it to your computer. Double-click the
Installation icon to copy the Mxpcdrv folder to %WINCEROOT%\PLATFORM\ automatically, and import the
supported Moxa Tech products into the Folder.

2. Start WinCE Platform Builder, and then select File >New Platform.

© Platform Builder - [Welcome to Platform Builder] E]E|

i) Fle Edit View Project Platform Target Build Project Build OS5 Tools Window Help == ﬂ
FF ~
2 T D | @ "
[} Mew Project or File...  Ctrl+Shift+M )
[ Cpen... cirl+0 BN
CE Close
Open Workspace... ~ )=
= & Catalog
=1 BSPs
+-(1 Core 08
+ 1 Device Drivers
Home +- [0 Platform Manager
+-([1 Third Party
Recent Files 3
Recent Workspaces [3
MNew Plz
Manage Catalog Items....
License Run-Time Image....
—_— w
Exit ¥
| ~
A
v
» | Build £/ Debug % Log Find in Files 1 Find in Files 2 /1 < >
Creates a new Platform Size: "0 KB ¥ |ER 3
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3. Enter a workspace name and then press Next.

New Platform Wizard - Step 2

YWorkspace Name And Location @
Choose a friendly name for your workspace.

Mame:
[Test] |
Path:

|E:\WINCE5I]I]'-.PBWOrkspaces'-.Test1\ ] E

w

4. When you see Board Support Packages, Design Template, Applications & Media, Networking &
Communications, OBEX Server, select what you need to build your own environment. The Completing the
New Platform Wizard window will open to indicate that it has created a new platform. Click Finish to
complete the setup.

New Platform Wizard - Step 4

Design Template b)

A design template is a pre-defined selection of Catalog items.

Available design templates: Choose the design template that is most
Custom Device closely aligned with the purpose of your
target device.

Digital Media Receiver

Enterprise Terminal Provides the starting point for a range of
-| YWeb Pad-based devices with touch display
Gateway and wireless networking.

Industrial Controller
Internet Appliance
IP Phone

Mobile Handheld
Set-Top Box

Tiny Kernel
Windows Thin Client

@ < Back Next > l [ Finish l [ Cancel
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New Platform Wizard - Step 5

Applications & Media @

Select items for applications and media to include in your OS design.

ltems:
o] NET Compact Framgwurk Support for applications and services
[] ActiveSync designed for the .NET Compact Framework.
-] DCOM

-[_| Lightweight Directory Access Protocol [LDi
—[] Standard SDK for Windows CE

- |»] ¥BScript support

-[v] Windows Media Audio/MP3

-[v] Windows Media Video/MPEG-4 Yideo

~[v] Windows Messenger

~.[v] WordPad

& [¥] Internet Browser

-l¥] Microsoft File Viewers

=[] Windows CE Error Reporting

hd | ?| Estimated size of these items: 10063 KB

@ < Back Next > l [ Finish ] l Cancel l

New Platform Wizard - Step &

Networking & Communications @
Select items for networking and communications to include in your 05
design.
ltems:
im [v| BEX St:rver | The foundation of the OBEX Application
TCP{IPv6 Support Framewrork that provides support for both

& Local Area Network [LAN) standard and user-defined services.

#-[| Personal Area Network [PAN]
#-[#] Remote Desktop Connection
w-[¥ Wide Area Network [YWAN]

Estimated size of these items: 10924 KB

E‘ < Back Next > l l Finish ] l Cancel
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Mew Platform Wizard - Step 7 &‘

OBEX Server

Security Warning

Under certain circurnstances, the Object Exchange Protocol (OBEX) catalog itern can compromise the
security of yvour platform, This catalog itermn poses the following potential security risks:

» If proper security and authentication technigues are not used, a service that interferes with services.exe
can be installed.

» If proper encryption techniques are not used, OBEX running over Bluetooth could expose data packets
to third parties,

To learn more about potential OBEX security risks, as well as the best practices for using this catalog iterm
more securely, see the following topics:

QBEX Security
Enhancing the Security of a Device

Mew Platform Wizard - 5tep 8

Completing the New Platform Wizard

You have successfully completed the New Platform Wizard.

You have created an 0S5 design for a Windows CE-based
platform. By default, Platform Builder provides a Debug
configuration and a Release configuration of this OS design.

Options:
& Modity build options for the Debug and Relesse configurstions of your 05
design without closing this wizard.

To close this wizard, click Finish.

(@) Next > . Finish I l Cancel

5. Select File >Manage Catalog Items In View —>Catalog, and browse \Third Party\Device Drivers\
MOXA Smartio/Industio-PC/104. Right-click on the driver Prefix COM or Prefix MXU you would like to
include and choose Add to OS Design.

NOTE

You can only select either Prefix COM or Prefix MXU, but not both.

Prefix COM supports up to 10 ports, from COMO to COM9. Prefix MXU supports more than 10 ports, so it is
better for you to select Prefix MXU if you are not sure how many ports the device has. Otherwise, you will only
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be allowed to use one multiport serial board on the target host.

D test2 - Platform Builder - [E:\...\Mxpcdrvimxpcdrvce5. reg]

File Edit Wew Project Platform Target Build Project Buld 05 Tools MWindow Help = H
ECEPC: xB86_Release | B &) [ & ¥ |CE Device v | 5m
A= L@ g OEDE B V| %
e IF CAMXU s k|
+- [0 Networking e [HKE‘:‘_LUCRL:MRCHINE\DI‘IUEI‘S\BulltIn\ = = E Catalo
<3 = SysIntr'=dword:1A X —
+- ] Parallel “IrqU=duord:A # 1 BSPs
+-( PC Card "IoBase"=multi_sz:"@18@","81co" t @ Cure. 0S5 )
+ ] PCI Bus “DevicearrayIndex'=dword: 0 & (1 Device Drivers
# [ Printer Devices “Prefix"="Mxu" . () Platform M
+-[23 Serial "Dp11V="mxpcdru_mxu.D11™ =/ Third Party
+ (] Smart Card “index™=duord: 8 =23 Device Drivers
+[] Storage Devices “Ordestduovded =-§ MOXA Smartiofindustio-PC{104 [Choose 1]
+-(1USB Host ';;}{;ﬁtg ;3;’::”;1"1" @ Mutiport Serial Board (Prefix COM]
- il Enterprise Web Pad[w “IsrHandler" ="TSRHandler" [ RMutiport Serial Board [Prefix MXU
+- [ Applications - End L “FIF0"=dword:1
+-[[] Applications and Se “CHIP"=dword:3
+-[_] Communication Ser
-4 Core 0S Services [MKEY_LOGAL_HACHINENDrLvers\BuiltIny e
+-(2] Debugging Tools "Tsp 5 Unlmﬁdem.dll Eind
@ Device Manager Ee?lcﬂyﬂe =dwu;d:§l S, ;
: “FriendlyName''=""Serial Cable on v Docking View
0 Display Support “DevConfig"=hex: 18,00, 80,08, Bt 2
[ Internet Applianc Hide
# [ Kemel Features [HKEY_LOCAL_MACHIME\Drivers\BuiltIn\ el
+- [] Notification LED “sysIntr=dword:1A e
=~ [@ Parallel Port Sup "Irq=dword:A L0okles
m Parallel Port [ “loBase"=multi_sz:"@188","61cO"
& PNP Notification: “DeviceArrayIndex''=dword:1
= = "Prefixt="Hxu"
Gl .
s 5
%/[added the Common Control feature (SYSGEM_COMMCTRL) to the platform. »~

lndded the Real-time Communications (RTC) Client API feature (SYSGEN _UOIP) to the platform.
GCompleted the feature and driver 1ist update successfully.

~

Build { Debug  Log b Find in Files 1 Find in Filzs 2 [IES ¥
Adds the selected feature to the platform Size: "22885 KB |3H =HEW X

6. After adding Moxa Tech drivers into your OS Design, a new project is automatically added to your workspace.
The project name is mxpcdrvce5.reg. The project can be accessed from View —>File View. The
mxpcdrvce5.reg project contains a number of files used to configure the drivers included in your OS Design. For
ISA boards, remember to set the IRQ and I/0 address in mxpcdrvce5.reg. For example, if your IRQ is 10,
IOBASE is 0180, Interrupt and Vector is 01c0, then you should configure “1A” for SysIntr, "0180” and “01c0”
for IOBASE, “A” for IRQ ,and “1” for FIFO. When applying the formula "IRQ+10", remember that IRQ is in base
10, and 10 is in Hex format. If we first convert the IRQ value to Hex format, then SysIntr will equal 1A.
Otherwise, set FIFO to 1 to enable the FIFO.

NOTE To use the “Terminal Emulator” tool, modify mxpcdrvce5.reg and keyboard as shown below (this is just for
“one” “"COM” port). Take note of the number of ports, COM, and MXU, and then enter the correct information.
[HKEY_LOCAL_MACHINE\ExtModems\HayesCompat1]

“Port”"="COM2:"
“DeviceType”=dword:1
“FriendlyName”="Hayes Compatible on COM2:"
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4 test2 - Platform B

AMxpedrvimxpedrvced. reg]

File Edit Wew Project Platform Target Build Project Buld 05 Tools MWindow Help

|CEPC: x86_Release el

i B ERER. A '_CE Device v|| 5a
3@ D ERE W 7| %
== [ IF CAMKU =]
7 [HKEY_LOCAL_MACHINEADrivers\BuiltIn\CAMXUA]
-8 E'\WINCEBHD “SysIntr”=dword:1A
] iﬁ?Fa“’,""‘es “Irqr=dword:A
= f Projects "IpBase"=multi sz:"e180","01co” 2 )
= mxpcdrveeb “DevicearrayIndex"=dword: 8 (1 Device Drivers
(2 Include files “Prefixt="Hxu" w0 Platform Manager

=1 Parameter files
mxpecdrvce5._bib
[E] mxpcdrveeb.dat
[Z] mxpcdrvceb.db
. mxcdrvceﬁ.re
rojsysgen.bat
[E] postlink.bat

prelink.bat

[ Resource files
(2 Source files

nxpcdru_mxu.D11™
“index”=dword:8
“order”=duord: 8
“Priority”=dword:@
mxisr.d11"
ISRHandler™

“GHIP"=dword:3

“Tsp”="Unimodem.d11"
“'DeviceType''=dword: 8
“FriendlyName"="Serial Cable on HXU 8:"
"DevConfig”=hex: 18,80, 660,008, 65,008,080,

[HKEY_LOCGAL_MACHINEXDrivers\BuiltIn\CAMXU1]
"sysintr=dword:1A
"IrqU=duord:A
“loBase"=multi_sz:"@188","61cO"
"DeviceArraylndex"=dword:1
“Prefix=""MiU"

nxpcdru_mxu.D11™

[HKEY_LOCGAL_HMACHINEADrivershBuiltIn\CAHXUB\Unimoden]

=3 Third Party

{2 Device Drivers

= MOXA Smartiofindustio-|
a Muliéurl Serial Board

@ Mutiport Serial Board

66, 16,01,00,8

—Avanaad a4 e < 3
> -
%/[added the Common Control feature (SYSGEM_COMMCTRL) to the platform. »~
lndded the Real-time Communications (RTC) Client API feature (SYSGEN _UOIP) to the platform.
GCompleted the feature and driver 1ist update successfully.
v
Build { Debug  Log b Find in Files 1 Find in Filzs 2 [IES ¥

Press F1 for Help

Size: "22885 KB %@ =W T

7. Finally, open Build OS, select Build and Sysgen, and be sure to click Copy Files to Release Directory After

Build and Make Run-Time Image After Build.

4} Z86CE - Flatform Builder - ... AUPOR Timocacom\MXTUCOM.cop]

[ Fie Edit ¥iew Projet Platform Terest Bulld Project |Budd 05 Took Window Help

== x|
CEPC: x86_Release B Syseen
BRI TR Byl and Syseen Curent BSP ) ) @ | |CE Device v %o
v Clran Before Buiding HXUCON.cpp : Defines ]
= 88 C:AWINCES 00 v Capy Fills to Release Directory After Build = & Catalog
+ (1 PLATFORM Make Run-Tims lmage After Budd i nclude “stdafx.n” & (1 BSPs
+(1 PRIVATE T include “MXUCOM.h™ @1 Core 08
+ (1 public SRR L e e ek include “'com.h" -1 Device Drivers
¢ Favorites Make Fun-Time Linoge include "Moxa.h" w1 Platform Manager
= Projects E a Third Party
= 8 mxpedrvees ONG  Dbglevel =DBG_D =3 Device Drivers
1 Include files Bsich Build. i = &) MOXA Smartiofindustio-PC{104 [Choose 1)
5-2 Parameter files B Open Release Directory eELne; il 1 [} [Mutiport Serial Board [Prefix COM]
:isz::z?::: ot bt et £ I_'lel @ Mutiport Serial Board [Prefix MXU)
2 Confi o) efine [:UM_EIHSE
2] mxpedrveeS.db Sl efine COM_Open
mxpedrveeb.reg #define GOM_Deinit
ProjSysgen.bat #define COM_Init
5] postlink.bat #define GOM_I10Control
2] prefink.bat #define COM_Read
[iResmm:e files #define COM_Write
s#endif
(3 Source files endr
BOOL
DLLERtry(
HINSTANCE
DYORD  u
LPUOID 1
)
<
DOUT(DBE INIT,(TEXT ¥
B 05DesignView | @ P View |* 4 ClassView | ] FileView | It L Izl

|[qdded the Real-time Conmunications (RTC) Client API feature (SYSGEN_UOIP) to the platform.
Completed the feature and driver list update successfully.

Build { Debug  Log % FmémFiles] % FndinFiles? 153

8. Finally, copy your image file to the target host.

NOTE If you created a Windows CE Platform Builder in the development environment, skip steps 2, 3, and 4.
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Older OS for CB Series

DOS

Moxa DOS API-232 is a software package that can help you develop or debug serial communications programs.
This section will explain how to install the package, set up the driver, and load or unload the driver. For
additional information about the API-232 library and utilities, please refer to Chapter 4.

The DOS drivers support all models in the CB Series.

In the following instructions, the CB-104 is used as an example.

Installing the Driver

Run the installation program, DOSINST.EXE, in the DOS folder. Specify the target directory for the API-232
files (e.g., C:\MOXA). Press F2 to start the installation.

I P AT S AT N

ol It ron

FAS Help tartanstallabaon

After the installation has been completed, you will be prompted to set up the board and driver initial values. We
strongly recommend that you do so.
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Driver Setup

The following instructions are not intended to illustrate every function of the setup program. For more detailed
information, please refer to the help files by pressing F1 in the setup program.

1. Run the setup program BIN\SETUP.EXE.

2. Select your CB Series model and press Enter.

3. A window will open, displaying all configuration information for all installed modules. Press PgDn to view
advanced port setup options and to make configuration changes. Your module’s configuration will be displayed

along with other settings such as port number, buffer size, etc.
4. Verify the settings and make any necessary changes.

Port Scbup

rong edat FAH = Eene fhort

Port number: This is the port ID of each port. Application software will refer to a port by its port
number (ID). Port numbers must be unique; duplicate port numbers are not allowed.
The port ID can range from 0 to 127 as long as it does not overlap with another port.
Generally, you should consider the convenience of programming when specifying the
port number.

TxD buffer size: This is the transmission (output) buffer allocated in the system for each port.
RxD buffer size: This is the receiving (input) buffer allocated in the system for each port.
F5: Group Edit: This allows you to configure several ports simultaneously as a group.

3-21



CA Series PC/104 Software Installation

g nh ILE] B

L=y Ed ks

= Ahart

5. Press F10 to save the latest configuration and exit the setup program.

Loading the Driver

After setting up the driver, you must load the driver in order to gain access to the serial ports on the module.
Run BIN\DPC-DRV.EXE at the DOS prompt. The driver will detect your CB Series module automatically. You
should see messages indicating successful detection of your module, such as the following:

Smartio/Industio Family DOS driver Version 1.8

Setup driver ...

CB-114 series (Bus=x, Dev=y): OK!

Device driver setup O.K.

At this point, you can execute applications that support API-232 functions, or start developing applications
using the API-232 library.

Unloading the Driver

To unload or release the CB Series driver from memory, enter DPC-DRV/Q at the DOS prompt.
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Windows NT

Installing the Driver

You will need to plug the board in an available PCI or PCI-X slot first, before installing the driver.
Note that these instructions use the CB-114 as an example. The procedure for installing all models is the same.
1. Log into Windows NT as Administrator.

2. Locate the appropriate folder for your board’s drivers on the Document & Software CD. The NT drivers will
be located under the product folder in the \Software\WinNT directory (e.g., under \CB-114 Series\Software).
Copy this folder to the PC’s hard disk and remember its location.

3. In the Control Panel, open Network applet. On the Adapters tab, click Add. When prompted to select a
product, click Have Disk....

You will be prompted to enter the path to the driver. Enter the location of the drivers that you copied from the
Document & Software CD (C:\Windows.nt in this example) and then click OK.

Ideliication | Sevices | Fiolocol Adartes | Birding: |

Me=ivacrk Sdspb=x: ‘
|1 Tl VI AR MO T ek e M ekl
"1 Salect Network Adapten K

Cick ibe Nebwork édepier that malches pour hadssie, snd then
B clicde CIE 1 aira s Fovie aniraballabinn disk bee thic commncesnl chels

Insert Desk

Irzeit dizk with softrane: provided By the sofvens or

haidware mandachaien IF the liles ca4 be lound &t 2
diferer lnation. for arampls o onother dive pe a

Pk path b the st helow. _Cancl |

|t

II:;\.'Wind:uws_n‘

or | canes

o, | comd |

4. When prompted, select your board model (Smartio/Industio Family multiport board in this example)
and click OK.

Select OEM Optinn

Choos= a softwaie suppoted by b hardware marilactrers disk.

i it P et baad

3-23



CA Series PC/104 Software Installation

5. After the files have been installed, a configuration panel will open. This is where boards are installed,
configured, and removed. If another board has already been installed on the system, it will already be listed.
Windows NT does not automatically detect Moxa UPCI boards, so you will need to click Add for a newly installed
board.

sl Muea Smariod | ndushio Condiguestson Pame]

Board Type 10 adcress | T rector | | Bus e | Co0 Mumber

[ I Propeay |
UK Lanz|

6. Under Board Type, select the UPCI board that is being installed. The window will show the COM settings for
the serial ports on the board. You can modify the COM settings for any port at this time by selecting a port and
clicking Port Setting. If you are satisfied with the COM settings, click OK to return to the configuration panel.

Property

Board Type

l-:r_ T ety AL

Interrupt No. 4¢ ;l

Baze |10 Port Address ASD

Port | COM Mo, | Rx FIFO Level | Tx FFFO Level

A COM3 High

2 COMd High High

3 COMS High High

4 COME High High
Port o Port Setting
OK Cancel
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7. The board will now appear in the configuration panel (CB-114 Series in this example). Click OK to return

to the Network applet. After that, click OK again to exit the Network applet

4k Moxa SmartiofIndustio Configuration Panel

Board Type

MO, H=1 19 =ernes LS00

ACOC 48 2 12

Eemove I

OK

VO address | INT vector | IRQ | Bus | Dev  COMMumber |

- COME

[{n T ]

Property

cancel

8. Restart the PC. After you have logged back into Windows NT, you may check the event log issued by the

Moxa driver to see if the board’s ports have been initialized successfully. In the Administrative group, open
Event Viewer and select Log and System. For each newly installed or configured Moxa UPCI board, check for
a message stating that the board has been enabled (e.g., "MoxaCB-114 board, with first serial port COM3, has

been enabled”).

Configuring the Ports

1. In Windows Control Panel, open the Network applet. In the Adapters tab, UPCI boards will appear as a
type of Moxa adapter (MOXA Smartio/Industio Family Adapter in this example). Select the Moxa adapter

and click Properties....

Ickniification | Serrces| Proocok  Adastar ] Birings |
Hedwark Adaphers:
@2 1] IntelF ) PROAD0WE Nehwork Commection

12] M D0, G rmartiod nchashic Farmil: Adepler

Add... Bemovs | Fropertis:... I Updst= I
tem Holes
b0 Smaitio/lndugto Famiy Adaple
ok Caniel
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2. The configuration panel will open with a list of installed boards. Select your board and click Property. Up to
four Moxa UPCI boards can be installed at a time.

4k Moxa SmartiofIndustio Configuration Panel ﬁ I

Board Type VO address | INT vector | IRQ  Bus  Dev  COMMumber |

MR T H=118 =eres AS00 AC0C 48 2 12 COM3 - COMBE

Eemove I Property
Ok ' Cance] |

3. Select a port to configure and click Port Setting.

Property
Board Type MOXE CB-114 Seties
¥ I wectar
Interrupt Mo, £ ;I
Base OPort Address |00

Port COM Mo, | Rx FIFOLevel TxFFO Level
i COM3 High High
2 COM4  High High
3 COMS  High High
4 COME  High High
e [fo Port Setting
oK Cancel
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Under Port Number, select a COM number to assign to the serial port. Select Auto Enumerating COM
Number to map subsequent ports in numerical order. For example, if COM 3 is assigned to Port 1, then COM

4 will be automatically assigned to Port 2.

o ]

I ALto Erumessting SR Mumer

Bt FFO Leved High =

¥ Sette changs to all poets

T FFi Leysl Hich

¥ Zetthe cheng=to |l ports

e} I Carcel |

4. Select an Rx FIFO Trigger and Tx FIFO Size. The default Rx FIFO Trigger is 120 bytes (high level). The

default Tx FIFO Size is 128 bytes (high level). Select Set the change to all ports to use this setting for all
serial ports on the board.

TxFIFO RxFIFO
High 128 120
Middle 64 60
Low 1 1

5. Click OK to approve the settings for the selected port. Continue in the same way to configure the other ports.

When you have finished setting up the ports, click OK to close the Properties window and apply the new port
settings. Click OK again to exit the Network applet.

ik Moxa Smartio/lndustio Configuration Panel

Board Type

MO T H=-1 14 =eres AR00

VO address | INT vector | IRQ@  Bus | Dev  COMMNumber |

Remove I
o« |

COM3 - COMBE

Property

Cancel |

Removing the Board

To remove a board, shut of your PC and physically remove the board from the PCI slot. The next time you start

up the PC, Windows NT will automatically remove the configuration. You do not need to go through the
Windows control panel.
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Updating the Driver

1. In Windows Control Panel, open the Network applet. Under the Adapters tab, UPCI boards will appear as
a type of Moxa adapter (MOXA Smartio/Industio Family Adapter in this example). Select the Moxa adapter

and click Remove.
Metwok ________________________HEH|
Ickniification | Serrces| Froocoks  Adastar ] Bincings |

Helwark Adaphers:
@2 [1] IntelF ) FROAD0YE Nehwork Comeclion

12] M0, G rnartiod moustio Farmil Adeapter

Add... (‘I Bemays gl:palﬁﬂ...l Updsts

tem Holes T—

Ot Srnaitio/Indosto Fanly Adapler

ok Cancel

2. Restart the system.
3. Go through the process of installing the drivers, using the new drivers.

Removing the Driver

1. In the Windows Control Panel, open the Network applet. Under the Adapters tab, UPCI boards will
appear as a type of Moxa adapter (MOXA Smartio/Industio Family Adapter in this example). Select the

Moxa adapter and click Remove.
[Newo ___________________________EH

Iceniiication | Services] Frotoels &datsn | Bindngs |

Hefwork Adaphars:
B2 (1] /=171 ) PRO/00VE Netuscek Cormeclion

1] W 0544 S mevtiod netustin Famiky &dopkes

A (I Femove | Wrcpeties. | Update

t=m Noles
0% Ermaio/Indate Fanly Acaple!

ok I Carcel
2. Click OK to exit the Network applet and restart the system.
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Windows 95/98/ME

Installing the Driver

Windows 95

1. After the board is physically installed and the PC boots up, Windows will automatically detect the new board
and the Found New Hardware Wizard window will open. Click Next to continue.

Update ey

Thig wizaid wil complece the ingalston of

P Seniel Contralle:

b canching paur lozal dives, netaor, zhd Inieinst
lacations far the mos! currers diter,

IF wou hawe a dik on CO-ROM tha come vath thiz davics,
aerk it o,

Ik 13 resommmended that pou let Windows search bor en
undried diver T da thes. chich Mgt o cantnue.

Canal

2. Select Other Locations...

Update Device Driver Wizard
whirdmas was Lnsble to ocale & diver for this devics=.
T da mol wark b install 2 diver now, dick Finigh. To

saichfor a driver manualp, cick Other Locations. Oi, o
Zegin the sutomatic gearch agsin, dick Back.

B |

3. Click Browse and select the appropriate directory on the Document & Software CD for the driver. Drivers for
all operating systems are located under the product folder in the \Software directory. Select the \Win9x
folder and click OK to continue.

Tpoe the name o e folder that cortans the diver youwart To zeach fona ldd=r, chek
Biowae

Liozehon

i |z

aF. Cancal
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4. After Windows finds the drivers, click Finish.

Add Hew Hardware Wizard

WWindows driver file search for the device:

MOxA CE-114 Senes [PC/104-Flug)

If wou want to use this driver, click Frish. If this iz not the
corect diver and you want to search for a different driver
manually, click Other Locations.

Location of Driver

:, Windows.95

Other Locations. .. I

{ Back

You can configure and use the new COM ports right away without restarting Windows.

Windows 98 and ME

1. After the board is physically installed and the PC boots up, Windows will automatically detect the new board
and the Found New Hardware Wizard window will open. Click Next to continue.

Add Hew Hardwere Wizard

Thiz wizerd smaches for mes direers For:

PCI Serial Coatraler

A device diiveriz o sofwane program thek nakes o
har e dheveics vork.
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2. Select Display a list... and click Next.

Add Mew Hardware Wizard

Whiat da you went Windaws o do?

T Seach lor e bezi diver for poun devize.
[Aezommerded|.

% Diaplay o lis: of ol the diversin a speofic :
ocalian, zoyou cen select the diver you wank i

< Back Mk = Canizel |

3. Select Other Devices and click Next.

Select the lwpe ol desics from the i belaw, thenclick
Hesk

Maveza ;l
Hukifunchion adaphsz

MuklDCarkialler

Wbk adepian:

[ ih=r det=cter devic=x

FLMCLS, sacked

Ports [COM & LFT)

o

B3 corirolien i
4 Back ek » Carcal I

4. Select Have Disk...

Sebect the manutachuer and madal of your hardwans davica, | vouhave 3
dizk that conbains the updaied diver, cick Have Disk To kel the updated
driver, dick Firigh.

Hawe Dk . I

£ Back Net> Cancal |

5. Click Browse and select the appropriate directory on the Document & Software CD for the driver. Drivers for
all operating systems are located under the product folder in the \Software directory. Select the \Win9x
folder and click OK to continue.

|zt the manwfactuier's instaldion dsk ino
—t the dive selected, and then cick OF.

Corp manutaciuier's Hles from:

|[ j Erowee...

3-31



CA Series PC/104 Software Installation

6. After Windows has installed the drivers, click Finish.

Add Mew Hardware Wizard I

_\> bl D5 CE =1 14 Series [FC04-Fluz]

Wirdows has finished installing the software you selected
that vour new hardware device requires.

Configuring the Ports

Configure the COM ports after the board and drivers have been installed.
1. In the Windows Control Panel, open the System applet.

| Fl= Edi “ew Bo Feeoiles  Hel gl
| & 2 W B sy :
Fiad: Fervard Up  Map Dies Diccoswsct Cur
| devess [ Conrdl Panel |
=1 == e
& I T
liddHew!  AddFenove  DesTime Dbl Fonis Gam=
(Hardwaie Froaiams Cori bers
; =y - <
G & S O W %3
Irbainet Feyboad e Mouga Fulimzcis eyl
Optiore
1 (& i alb:
g 4 »2 @ =
QDEC Data Paesmords Powszr Prickeis Regina Bounds
S [l Hlaregenent Settirge
LB
|21 obiec=] I_E My Compuie o
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2. In the Device Manager tab, expand the Moxa Smartio/Industio multiport board category by clicking
the “+" sign next to it. Select the desired board and click Properties.

System Propciues

GE

& View devices by lype

atdwae Profiles | Peiformance |

™ Yiew devices by connecton

_\:'_! Computer

-2 COROM

=3 Disk drives
Display adapters
Floppy disk controllers

=&
=]
1528 Hard disk controllers
‘55

(¥ B[ - B I:!-

Keyboard
Monitors

l+J

w5 Ports (COM & LPT)
E System devices

Propesties | Refresh I

3. Under the Ports Configuration tab, select a port to configure and click Port Setting.

Property E3 I
Board Type A CB-114 Series
B T ector
Irterrupt Mo, 18 -
Baze /O Port Address AGUO

Port | COMYo. | Rx FIFO Level | Tx FFO Level '

COM3 High

1 :

2 COMd  High High
3 COMS  High High
4 COME High High

Eartint I Port Setting |

Ok Cancel I
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Under Port Number, select a COM number to assign to the serial port. Select Auto Enumerating COM
Number to map subsequent ports in nhumerical order. For example, if COM 3 is assigned to Port 1, then COM
4 will be automatically assigned to Port 2.

I+ Auto Enumeseting Ol Plumier

For Mumbar

B FFO Level High =

[ Set e chngs to sl pots

Tx FFO Lewsl High =

[ =& tre chang=to |l ports
i I

4. Select an Rx FIFO Trigger and Tx FIFO Size. The default Rx FIFO Trigger is 120 bytes (high level). The
default Tx FIFO Size is 128 bytes (high level). Select Set the change to all ports to use this setting for all
serial ports on the board.

Carce| |

TxFIFO RxFIFO
High 128 120
Middle 64 60
Low 1 1

5. Click OK to approve the settings for the selected port. Continue in the same way to configure the other ports.
When you have finished setting up the ports, click OK to close the Properties window and apply the new port
settings. Click OK again to close the Device Manager and restart the system.

Updating the Driver

You may configure the COM ports after the board and drivers have been installed.
1. In the Windows Control Panel, open the System applet.

B3 Controd Panel
| Ble Edk Mew [Go Fawaites  Hep
- . =+ 4 g = -
Eaody SELETC Up Map Orive  Dkeoorie| Cul
Addiess |5 Conim Parel =
1f2 [ 3
S G5 = e
ifddWew!  AddiRemove  DaleiTime Cisplay Fanis Giame
Haldwanm, PIograims: Conwoled:
. ey ; -
&G = @ O B =23
Inlemret F. ey Modens Mouse Mulimede Hetuerk:
Opliors
i N I ¥ : il
& N9 = 9 g
ODBC DAt Pacswaids Pk Frideiz Hegicina Sourds
Soaces [Z2hi) W anagsme Sethngs
| Isers
1 izl =l Conpuer 7
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2. Under the Device Manager tab, expand the Moxa Smartio/Industio multiport board category by
clicking the “+" sign next to it. Select the desired board and click Properties.

System Proiciues

1%} COROM

(- Disk diives

-3 Display adapters
-5 Floppy disk controllers
#-62 Hard disk controllers
@ Keyboard

-3 Monitors

wa SmartioIndustio mukiport board

@ Ports (COM &LPT)
[+ [H System devices
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4. Select the appropriate model (CP-168U in this example) and click Have Disk...

Update Device Driver Wizard I

_\> Select the manufacturer and nodel of your hardweare device. If you have &

dizk that containg the updated driver, click Have Disk. To install the updated
driver, click Finish,

Models;
CP-104U Senes -
CP-114 Sernies —!
CM-132 Series

CP-1321 Senes

CP-134U Series _]
=

CB-114 Series

FT-114 Seres

Have Disk... |

< Back Nest> | Cancel |

5. When prompted, select the appropriate directory on the Document & Software CD for the driver. Drivers for
all operating systems are located under the product folder in the \Software directory. Select the \Win9x
folder and click OK to continue.

6. You will be prompted to restart the system. The new drivers will be in effect the next time you restart.

Removing the Driver

1. In the Windows Control Panel, open the Add/Remove Programs applet. On the Install/Uninstall tab, select
MOXA Smartio/Industio Driver and click Add/Remove.

Ingtall/Uringtall | windows 5 ehup | St Disk |
) Tairsikal a e progiam fiam a Aoppy disk or CO-ROM
= dirve, dick |nstal.

Izl

? The lallawig aalbeam con b avtomateolly mmosed by
' “windows. To iemaws 2 piogram or lo modifp ts nstelled

componenls, sebect it rom the list 2nd click
AddRemove

Ay aee 8097 Budi
Inle=(H] PAD Ethemet Adepier ard Sollwae
b Ol Ernailie Inchsta D

Sis 91T

A,od/H e |

ok | Carcel I Eripl I

2. When prompted, click Yes to confirm that you want to remove the driver.

MO0=A Smantiodlndustio Driver
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3. After the driver has been removed, click OK to return to the Add/Remove Programs applet.

martio/lnduetio Diiver

Remaone MO 5 martiodIndustio Drves comolehs |

Windows CE 5.0

In this section, we explain how to install Moxa CB series boards under WinCE 5.0. These instructions are
intended for users who are familiar with the Windows CE Platform Builder 5.0 Toolkit, and would like to install
one or more Moxa Tech products. Here, we only give the step-by-step installation instructions for the
development environment. You will need to download the image file to the target host yourself.

The WiInCE 5.0 driver for the Moxa CB Series PC/104-Plus Multiport Serial Module supports the following
products:

CB Series: CB-108, CB-114, CB-134I

The CB-114 board is used to illustrate the installation procedure.

Installing the driver

The following procedure explains how to install the CB-114 multiport serial module driver under WinCE.

1. Obtain a copy of Moxa Tech WinCE 5.0 driver package and extract it to your computer. Double-click the
Install package to copy the Mxser folder to %WINCEROOT%\PLATFORM\ automatically, and import the
supported MOXA Tech products into the Folder.

2. Start WinCE Platform Builder, select File, and open New Platform.

%5 Platform Builder - [Welcome to Platform Builder] E@E|

Eile Edit View Project Platform Target Build Project Buld OS5 Tools Window Help - = ﬂ

P =
é m] New Platform... Ctrl+M o = E I%ﬂ E& v ?H
[} Mew Project or File...  Cirl+Shift+M i
[ Open... ctrl+0 EIR.)
CE Close
Open Workspace... ~ =
= B Catalog
=1 BSPs
=[] Core 0S
+- [ Device Drivers
Home Fr—. +-_1 Platform Manager
+-_1 Third Party
CHWINCES
\PBWorksp
CHWINCES
Recent Files 3 ACP18SUME
Recent Workspaces 3
MNew Plz
Manage Catalog Items.... .
License Run-Time Image....
[ v
Exit *
X ~
|
v
b % Build ¢ Debug % Log % Find in Files 1 Find in Files 2 /1 < >
Creates a new Platform Size: "0 KB ¥= kR e
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3. Enter a name for Workspace and press Next.

New Platform Wizard - Step 2

YWorkspace Name And Location @
Choose a friendly name for your workspace.

Mame:
[Testl] |
Path:

[:E:\W|NCE5umPBWurkspaceswesnu | fd

4. When you see Board Support Packages, Design Template, Applications & Media, Networking &
Communications, OBEX Server, select what you need to build your own environment. The Completing the
New Platform Wizard window will open to indicate that it has finished creating a new platform. Click Finish
to complete the setup.

New Platform Wizard - Step 4

Design Template b)

A design template is a pre-defined selection of Catalog items.

Available design templates: Choose the design template that is most
Custom Device closely aligned with the purpose of your
target device.

Digital Media Receiver

Enterprise Terminal Provides the starting point for a range of
EﬂtﬂffiSE ¥Web Pad |  Web Pad-based devices with touch display
Gateway and wireless networking.

Industrial Controller
Internet Appliance
IP Phone

Mobile Handheld
Set-Top Box

| Tiny Kernel
'Windows Thin Client

@ < Back Next > l [ Finish l [ Cancel
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New Platform Wizard - Step 5

Applications & Media @

Select items for applications and media to include in your OS design.

ltems:
o] NET Compact Framgwurk Support for applications and services
[] ActiveSync designed for the .NET Compact Framework.
-] DCOM

-[_| Lightweight Directory Access Protocol [LDi
—[] Standard SDK for Windows CE

- |»] ¥BScript support

-[v] Windows Media Audio/MP3

-[v] Windows Media Video/MPEG-4 Yideo

~[v] Windows Messenger

~.[v] WordPad

& [¥] Internet Browser

-l¥] Microsoft File Viewers

=[] Windows CE Error Reporting

hd | ?| Estimated size of these items: 10063 KB

@ < Back Next > l [ Finish ] l Cancel l

New Platform Wizard - Step &

Networking & Communications @
Select items for networking and communications to include in your 05
design.
ltems:
im [v| BEX St:rver | The foundation of the OBEX Application
TCP{IPv6 Support Framewrork that provides support for both

& Local Area Network [LAN) standard and user-defined services.

#-[| Personal Area Network [PAN]
#-[#] Remote Desktop Connection
w-[¥ Wide Area Network [YWAN]

Estimated size of these items: 10924 KB

E‘ < Back Next > l l Finish ] l Cancel
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Mew Platform Wizard - Step 7 &l

OBEX Server

Security Warning

Under certain circurnstances, the Object Exchange Protocol (OBEX) catalog itern can compromise the
security of yvour platform, This catalog itermn poses the following potential security risks:

» If proper security and authentication technigues are not used, a service that interferes with services.exe
can be installed.

» If proper encryption techniques are not used, OBEX running over Bluetooth could expose data packets
to third parties,

To learn more about potential OBEX security risks, as well as the best practices for using this catalog iterm
more securely, see the following topics:

QBEX Security
Enhancing the Security of a Device

(7] J [ < Back Mext >

Mew Platform Wizard - 5tep 8

Completing the New Platform Wizard

You have successfully completed the New Platform Wizard.

You have created an 0S5 design for a Windows CE-based
platform. By default, Platform Builder provides a Debug
configuration and a Release configuration of this OS design.

Options:
& Modity build options for the Debug and Relesse configurstions of your 05
design without closing this wizard.

To close this wizard, click Finish.

@J Mext >  Finish I l Cancel
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5. Open Manage Catalog Items (File >Manage Catalog Items). Under Catalog (View —>Catalog), browse
t\Third Party\Device Drivers\ MOXA Smartio/Industio-PCI, PC/104-Plus. Right-click on the driver
Prefix COM or Prefix MXU you would like to include and choose Add to OS Design.

NOTE

You can only select either Prefix COM or Prefix MXU, but not both.

Prefix COM supports up to 10 ports, from COMO to COM9. Prefix MXU supports more than 10 ports, so it is
better to select Prefix MXU if you are not sure how many ports the device has. Otherwise, you will only be

allowed to use one multiport serial board on the target host.

‘5 test - Platform Builder - [Welcome to Platform Builder]

Ei|E Edit Wiew Project Platform Tapget Build Project Build ©5 Tools Window Help

|CEPC: x86_Release v B &) [ [ € |CE Device ¥ 5m
Sy - o A G %
=l =lx
=88 test Catalog items S = K Catalog |
+ -3 CEPC: x86 & 1] BSPs
+-(Z] Device Drivers 2 Core 08
= iy Enterprise Web Pad[Windows {10 Device Drivers
+-[Z1 Applications - End User Home 5 [ Platform Manager
+ [ Applications and Services | ame = Third Party
+ L] Communication Services a EAWINCESE =23 Device Drivers
-3 Core 05 Services E4WINCEST = @ MOXA Smartiofindustio-PCLPC{104-Plus [Choose
#-(1 Debugging Taals ]
[l Device Manager New Plal @ Mutiport Serial Board [Prefi
[l Display Support ]
[ Internet Appliance [IABA
+[[1 Kernel Features Refresh Catalog
- [] Notification LED Suppor Eind
=i~ @ Parallel Port Support =
(5{Paralll Port Diver| o  cingen
[ PNP Notifications Hide
# [ Power Management [Ful
@ Serial Port Support Ron - o
& Ul based Notification ring SoBeiaes
+#- [y USB Host Support Devir
+ (L1 File Systems and Data Stol Wind
+ (] Fonts Yearl
+-[] Graphics and Multimedia T thro
+ (] International 2 Micrc
< == — Wing
B 0SDesi... ]@Palamet...]% FiIeViewJ < ES < ¥
=|[Added the Real-time Communications (RTCG) Client API feature (SYSGEN_VODIP) to the platforn. ~
Completed the feature and driver list update successfully.
v
Build £ Debug 3 Log 3 Find in Files 1 Find in Files 2 | < b3

Adds the selected feature to the platform

Size: "22005 KB |3H =HERE 3
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6. After adding Moxa Tech drivers into your OS Design, a new project is automatically added to your
workspace. The project name is mxserce5. The project can be accessed from File View (View >File View).
The mxserce5 project contains a number of files used to configure the drivers included in your OS Design.

D test - Platform Builder - [E:\...\Mxser\mxserce5. reg]

File Edit Wew Project Platform Target Build Project Buld 05 Tools MWindow Help

|CEPC: %86 _Release | B & [ & ¥ |CE Device
gle L o | SIE™
== IF PCIHXU f
+ 88 EA\WINCE5DD [HKE‘:‘_L.[!IIﬂL_MﬂEHINE\Dri:.:el‘S\BuiltIn\FBI\TemplatE\MUXH
g D11"=""mxser_mxu.D1l
bcq Fav.omes “ppefiy="HMXD"
= & Projects "UendorID"=multi_sz:"1393","1393","1393","
= @ mxserceh “DeviceID"=multi_sz:""1822","1621","1321","
1 Include files “Class”=duword: 87
1 Parameter files “SubClass"=dword: @0
mxserce5.bib “index"=duord:8
mxserceb.dat "IsrD11"="mxisr .d11"
mxserces.db "ISI‘Handlll?l‘"="ISRHandlel‘"
“Tsp"="Unimodem.d11"
* "DevicefrrayIndex"=dword:8
ProjSysgen.bat “Order”=dword: 8
=] postlink.bat “DeviceType''=dword: @
[5] prelink.bat “FriendlyMame"="HOXA Serial Port

“FIF0"=dword:1
“GHIP"= dword:1

[ Resource files
(2 Source files

[HKEY_LOCAL_MACHINEADrivers\BuiltIn\PCI\Template\HOXA
"Tsp"="Unimodem.d11"
"DeviceType”=dword: @
"DevConfig=hex: 10,00, 06,080, 65,00,00,00, 10,01
"FriendlyName™="Serial Cable on MXU B8:"

[HKEY_LOCAL_MACHINEADriversi\BuiltIniMXU1]
“Order"=dword:100
[HKEY_LOCAL_MACHINEADrivers\BuiltIniMXU1\Unimodem]
"Tsp"="Unimodem.d11"
"DpuircATune=dunrd:A

Bos.. @ Pa...| 401 | HFiL. [} 3

v

_l=]x|
v |5
2l
= &l Catalog
@ (1 BSPs
- Core 0S

[ Device Drivers
=3 Platform Manager
=3 Third Party
=3 Device Drivers
=) MOXA SmartiofIndustio-PCLF
@ Mutiport Serial Board [Pre

[ [Mutiport Serial Board [Pre

< >

l[added the Real-time
Completed the featu

CommulFileYiew
€ and driver list update successfully.

Build { Debug  Log b Find in Files 1 Find in Filzs 2 [IES

Press F1 for Help

ons (RTC) Client API feature (SYSGEN_UDIP) to the platform.

v
»
Size: "22885 KB 28 =1FH =

NOTE

If you would like to use the “Terminal Emulator” tool, please modify mxserce5.reg and keyboard like below

(This is only just for “one” "COM” port). You have to take note of the number of ports, COM, MXU, and enter the

correct information.

[HKEY_LOCAL_MACHINE\ExtModems\HayesCompat1]
“Port”"="COM2:"

“DeviceType”=dword:1

“FriendlyName”="Hayes Compatible on COM2:"”
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7. Finally, open Build OS, select Build and Sysgen, and be sure to click Copy Files to Release Directory
After Build and Make Run-Time Image After Build.

5 a_test - Platform Builder - [Welcome to Platform Builder] EE|
Eile Edit View Project Platform Target Buid Project |Buld 05 Tools Window Help ~ = E
3 | = =i} o= B sysgen v | %
CEPC: x86_Release Build and Sysgen Current BSP @ @
CE Device - J;’EI Clean Before Building
v Copy Files to Release Directory After Build
2l ) P
- v Make Run-Time Image After Build
[7] ActiveSync ~ Catalog
File Sync Copy Files to Release Directory 1 BSPs
[l CAB File Instal Make Run-Time Image (1 Core 08
+-[] File Viewers (1 Device Drivers
& Help Home (1 Platform Manager
+-_] Remote Deskkc Batch Build. .. [ Third Party
&I WordPad = Open Releasze Directory

[_1 Applications and !
_1] Communication §
[_1 Core 05 Services Configurations. ..
(L1 File Systems and

[J Fonts New Plz
79 franhice and Mol ¥ 1 _
>

Set Active Configuration...

O O o o 2 O

<
Bo.. [@r. "o =] (< >

#|[added the Conmmon Control feature (SYSGEN_COMMCTRL) to the platform. ~
Completed the feature and driver 1list update successfully.

b

v
>

¥ [% Build ¢/ Debug % Log % Find in Files 1 Find in Files 2 /1 <

Builds files in the tree for this 05 design and then runs the Sysgen tool, and builds proje Size: 17412 KB #® <& 3

8. Finally, copy your image file to the target host.

NOTE If you have created a Windows CE Platform Builder in the development environment, skip steps 2, 3, and 4..

Newer OS for Both CA/CB Series

The content below will describe the software installation for newer Windows OS, including Windows
2000/XP/2003/Vista/2008/7/8/8.1/10 (x86/x64), Windows Server 2008 R2/2012/2012 R2/2016 (x64)

The following topics include

d Installing the Driver
Configuring the Ports
Checking the Status
Removing the Driver
Uninstallation the Driver

[ R R R |

We will take Window 7 (x64) for example, to let you know how to install your CA or CB boards. The installation
procedure of Windows?7 is similar to the other Windows platforms. The content describes how to install,
configure, check the port status, remove, or uninstall the CA or CB boards.

NOTE In the installation section, the CA Series has more installation procedures as it follows the ISA standard. The
content will be added, followed by the installation part of CB Series.
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Installing the Driver

In this section, we will describe how to install the CA or CB boards for the first time with Windows 7.
First, make sure that you have already plugged the board or boards into the system’s PC/104 or PC/104-Plus
slot(s).

NOTE

If you have already installed Moxa CA or CB board(s) in your computer, and you are installing additional
boards, Windows 7 will automatically detect and install the new board(s) the next time you boot up the
computer. In this case, proceed directly to the next section, “Configuring the Ports,” to configure the ports’
serial transmission parameters.

Second, download the drivers at www.moxa.com. Based on the OS type, choose the corresponding driver.
Then, follow the following procedures to install the driver.
1. The Setup Wizard will open. Click Next to install the driver.

EJ Setup - MCRA Smartiofdndustio Windows Driver E' (=] @

Welcome to the MOXA
h Smartio/Industio Windows Driver
fﬁ Setup Wizard

Thiz wall ingtall MO Smarhiodndustio Windows Driver Werl .24
ar YoLr computer.

It iz recommended that you cloze all other apphcations before
cohbinuing.

Click Mest to continue, or Cancel ta exit Setup.

M et > ]| Cancel

2. Please read the license agreement. If you agree, click Next to move on.

1SJ Setup - MOXA Smartio/ndustio Windows Driver EI =] @
License Agreement h
Please read the fallawing important information befare cantinuing. C

Please read the fallowing License Agreement. You must accept the terms of this
agreement before continuing with the installation.

MOXA FND-USER LICENSE AGREEMENT -
FOR MOXA SMARTIO/INDUSTIO WINDOWS DRIVER

IMPORTANT: Please Read This Agreement Before Using The Software
Indicated Above.

This End-User License Lgreement (“EULA™) is a legal agreement between you,
the Customer (either as an indfvidual or a single entity), and the Owner
concerning this special purpose (“Systera”) corputer device that includes certain _
£: B L L I L POT N | MW

Plarrmey ardbaren:

| do nat accept the agreement

¢ Back |[ Mest » ]| Cancel
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3. Click Next to install the driver in the indicated folder, or use the drop-down folder list to locate a different
folder.

EJ Setup - MCHES Smartiofdndustio Windows Driver E =]

Select Destination Location
Where shauld MO=A Smartiodndustio \Windows Driver be installed? C

=4[

Setup will install MOXA Smartiod ndustio “Windows Driver inta the following
folder.

To continue, chok Mext. IF you would like to select a different folder, click Browse.

| Browse. ..
At leazt 0.8 MB of free dizk zpace iz required.
< Back |[ Mext » ] | Cancel
4. Click Install to proceed with the installation.
r |
EJ Setup - MCHES Smartiofdndustio Windows Driver E

Ready to Install

Setup iz how ready to begin ingtaling MOXA Smartiodlndustia Windows Driver on C
Yaur computer,

=4[

Click Inztall bo continue with the installation, ar click Back if vou want to review or
change any settings.

Destination location: r
C:\Program Files'h oxahSmartiol ndustioDriver

< Back |[ [nztall ]| Cancel
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5. Click Finish to complete the installation of the driver.

ILE;-! Setup - MOXA Smartiodndustio Windows Driver o || B ER

Completing the MOXA
Smartio/Industio Windows Driver
Setup Wizard

Setup has finizhed installing MOxA Smartiondustio \Windows
Diriver an your compriker.

Click Finish bo exit Setup.

If your model is from the CB Series, then the installation is done. Otherwise, you need to do the following steps
to complete the installation for the CA Series (CA-114 Series is taken as example).
1. Select Add Hardware Wizard from the Control Panel. When the wizard opens, click Next to continue.

Add Hardware Wizard

Welcome to the Add Hardware Wizard

5

Thiz wizard helpz you;

* |nztall zoftware to support the hardware vou add to your
cornputer.

* Troublezhoot problems you may be having with pour
hardware.

& IF your hardware came with an installation CD,
it iz recommended that you click Cancel to
close thiz wizard and use the manufacturer's
CD to install thiz hardware.

To continue, click Mest.

uexw |[ Cancel
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2. Select Yes, I have already connected the hardware and click Next to continue.

Add Hardware Wizard

Iz the hardware connected?

Have vou already connected thiz hardware to pour computer’?

#fes T have already connecied the hardwarg
("1 Ma, | have not added the hardware yet

’ < Back ” Hext = ][ Cancel ]

3. Select Add a new hardware device and click Next to continue.

Add Hardware Wizard

The following hardware iz already installed on your computer

From the list below, select an installed hardware device, then click Mest to check
properties or troubleshoat & problemn pou might be having.

To add hardware not shown in the Bist, click “4dd a new hardware device. "'

Inztalled hardware:

5& IntellR] 328010B/DBM USEZ Enhanced Hoszt Contraller - 24C0 A
& 1USE Root Hub
& 1USE Root Hub
& 1USE Root Hub
& 1USE Root Hub

Add a new hardware device

¢ Back H MHewt > ][ Cancel
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4. Select Install the hardware that I manually select from a list (Advanced) and click Next to continue.

Add Hardware Wizard

The wizard can help you install other hardware

The wizard can search for other hardware and automatically install it for youw, Or, if wou
know exactly which hardware model you want boingtall, you can select it from a list.

wihat do you want the wizard ko da?

(") Search for and install the hardware automatically [Fecommended]

[ ¢ Back H MHewt > ][ Cancel ]

5. Select Multi-port serial adapters and click Next to continue.

Add Hardware Wizard

From the list below. zelect the type of hardware you are installing

[f you do not zee the hardware categary you want, click Show All Devices.

Comrman hardware types:

Show Al Devices ”
§ Dizplay adapters
=5 1DE ATAMTAP| contrallers
&2 |IEEE 1394 Busz host contrallers
8 |maging devices
.E] Infrared devices
L Modemns
=1 b ulti-port serial adapters
B B sbissele 2l smbars 4

¢ Back H MHewt > ][ Cancel
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6. Select your CA Series model and click Next to continue.

Add Hardware Wizard

Select the device dnver you want to install for this hardware.

Select the manufacturer and model of pour hardware device and then click Mest. 1f you
have a dizk that containg the driver pou want to install, click Have Digk.

tadel S

b Oty CAT04 Senies
b Oy, CAT0S Senies

04 CAT14 Serez
b Oty CAT 32 Senies

& This driver iz not digitally signed!

Tell me why driver zigning iz important

W

[ ¢ Back H MHewt > ][ Cancel ]

7. To begin installing the module, click Next.

Add Hardware Wizard

The wizard iz ready to install your hardware

Hardware to install;

Sl MOKa CA114 Series

To start inztaling pour new hardware, click Mext.

< Back { [ Cancel
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8. If you see a warning that the software has not passed Windows Logo testing, click Continue Anyway.

Hardware Installation

L] 'I_., The saoftware you are installing for this hardware;
L
kO CA114 Series

has not paszed Windows Loga testing ta verify itz campatibility
with "Windows =P, [Tel me why this testing i impartant. |

Continuing your installation of thiz software may impair
or destabilize the comrect operation of your system
either immediately or in the future. Microsoft strongly
recommends that pyou stop thiz inztallation now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo testing.

[ Continue Arnpray ] EéTEIF'InstallatiDn |

9. Windows will install the drivers. When the installation has been completed, click Finish.

Copying Files... E]

mizpart, sy
To CAwWIMDOWShaystem3I2ADRIVERS

Cancel

Add Hardware Wizard

Completing the Add Hardware Wizard

5

The following hardware was installed:

m b Dx4d CA114 Senes

YWindowes haz finished installing the zoftware for this device.

To cloge thiz wizard, click Finish.

Finizh
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10. After the module has been installed, you will be prompted to install the new serial ports. A Found New
Hardware Wizard window will open for the first serial port, port 0. Select No, not this time and click Next.

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will zearch far curent and updated software by
looking on your computer, on the hardware installation CO, or on
the windows pdate ‘Web zite [with pour permizsian).

FAead our privacy policy

Can wWindows connect to wWindows Update to search for
goftware?

{1 es, thiz time only
{1 Y'es. now and

@

Click Mest to continue.

[ MHewt > ][ Cancel

11. Select Install from a list or specific location (Advanced) and click Next.

Found Mew Hardware Wizard

Thiz wizard helpz you install zoftware faor;

kD, commurication port

\:J If your hardware came with an installation CD
2= or Hoppy dizk. insert it now.

What do you want the wizard to da?

(71 Inztall the software automatically [Fecommended)
{(®xiinztall from a list or specific location [Advanced)

Click Mest to continue.

¢ Back H MHewt > ][ Cancel
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12. Select Search for the best driver in these locations and Include this location in the search. Select
the \Program Files\MOXA\SmartioIndustioDriver folder on the C drive disk, and click Next.

Found New Hardware Wizard
Flease choose your search and installation options. -5

(%) Search for the best driver in these locations.

Use the check bores below ta limit or expand the default zearch, which includes local
paths and removable media. The best driver faund will be installed.

[] Search removable media (floppy. CO-ROM.]
Include this location in the search:

w Browse

(O Don't search. | will choose the driver to install.

Choose thiz option ta select the device driver from a list. “Windows does not gquarantee that
the driver pou choose will be the best match far your hardware.

[ < Back “ Mext > ] [ Cancel ]

13. If you see a warning that the software has not passed Windows Logo testing, click Continue Anyway.

Hardware Installation

L] E The saoftware you are installing for this hardware;
L
kA O Prort O

has not paszed Windows Loga testing ta verify itz campatibility
with "Windows =P, [Tel me why this testing i impartant. |

Continuing your installation of thiz software may impair
or destabilize the comrect operation of your system
either immediately or in the future. Microsoft strongly
recommends that pyou stop thiz inztallation now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo testing.

[ Continue Arnpray ] EéTEIF'InstallatiDn |

14. Windows will install the necessary drivers.

Found New Hardware Wizard

Pleaze wait while the wizard installz the software_ .

3 MI0A Port 0

n -,

Setting a system restore point and backing up old files in
caze pour spztem needs to be restored in the future,
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15. After the installation is complete, click Finish.

Found Mew Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished ingtaling the zoftware for;

(3 kD30 Port 0

Click. Finizsh to cloze the wizard.

16. Repeat the installation process for the remaining serial ports.

Configuring the Ports

After the driver has been installed, use Device Manager to configure the serial port of your CA or CB boards
(CB-134I Series will be used as example).

In this section, we describe how to access MOXA Smartio/Industio Window Driver and lead you to do the serial
port configuration.

a Accessing MOXA Smartio/Industio Window Driver
a Configuring Serial Port

> Port Number

> Rx, TX FIFO
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Accessing MOXA Smartio/Industio Window Driver
Expand the Multi-port serial adapters tab, right-click CB-1341I Series (PC/104-Plus), and then click
Properties to open the board’s configuration panel.

+=n Device Manager EI@

File  Action View Help
=m0 BE) C @ %S

4 = 3pagd?
M Cormputer

Actions

. X Device Manager on local co,., &
sy Disk drives

» B, Display adapters Mare Actions »
=4 Floppy disk drives

3 .\:H Floppy drive controllers

3 ﬁwJ Hurman Interface Dewvices

b g IDE ATASATAPT contrallers
b2 Keyhoards

b (iﬂ Mice and other pointing dewvices
| Monitors

477 Multi-port serial adapters

{7 MOXA CB- T3l Seres (PCA0F =

: ate Driver Software..,
& Metwork adapters Q

a-|[5 Other devices Disable

o e[l Unknown device Uninstall

> T3 Porks (COM & LPT)

o ¥ Processars Scan for harduvare changes

)--J,, Sound, video and game contrallg
i ety High Definition Audio Device
K| Systern devices

Properties

>

> g Universal Serial Bus controllers

Opens property sheet for the current selection,

Configuring the Serial Ports
Port Number

1. Click the port you would like to configure to highlight it and then click Port Setting.

MDA CB-1341 Series (PC/104-Rlus) Properties 23]

General | Ports Configuration | Diriver I Details I Hesnurcesl

Port | COM Mo, | R« FIFO Level | T« FIFO Level

2 COM 2 High High
3 COM 2 High High
4 COmM 4 High High

Help

Pot Info

Fort Setting

A

Ok, l [ Cancel
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2. Select a COM number for the port from the Port Number pull-down list. Select the Auto Enumerating
COM Number option to map subsequent ports automatically. The port numbers will be assigned in sequence.
For example, if COM 1 is assigned to Port 1, then COM 2 (if not already occupied) will be assigned to Port 2, etc.

Portl

Part Humber

v Auto Enumerating COM Murnber
R FIFO Lewel |High -

v Setthe change to all ports
Tw FIFO Level |High -

[v Set the change to all ports

(] Cancel |

Rx, TX FIFO

1. Select an Rx FIFO Trigger from the Rx FIFO Level pull-down list. Rx FIFO trigger levels of High, Middle,
and Low are available, with the default set to High. Select the Set the change to all ports option to apply this
Rx FIFO Trigger to all ports.

2. Select a Tx FIFO Level from the Tx FIFO Level pull-down list. Tx FIFO Levels of High, Middle, and Low

are available, with the default set to High. Select the Set the change to all ports option to apply the just
defined Tx FIFO Size to all ports.

Tx FIFO Rx FIFO

(Byte) (Byte)

CA Series CB Series CA Series CB Series
High 64 128 56 120
Middle 32 64 28 60
Low 1 1 1 1

3. Click OK to save the port settings and then click OK in the Property window to finish the port settings
procedure.

Checking the Status

The PComm Diagnostic program is a useful tool to check the status of Moxa’s multiport serial boards. The
program can be used to test internal and external IRQ, TxD/RxD, UART, CTS/RTS, DTR/DSR, etc. Use this
program to ensure that your Moxa boards and ports are working properly.
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To start the program, click Start> Programs-=> MOXA-> PComm Ver 1.X=> PComm Diagnostic

& Internet Explorer (64-hit)
& Internet Explarer
] Windaows DVD Maker
EE8 Windows Fax and Scan
 Windows Media Center
@ Weindowes Media Player
1 vivindows Update
o HPS Viewver
J Accessories
| Games
J Maintenance
J Moxa
Dy
, PComm Lite Werlt
|5§H) Library Programrning
|5§H) Library Reference
¥2 PCaornm Diagnostic
5{3 PComm baonitor

ﬂ PCornm Terminal Emulator

el Performance Analyzer

4 Back

Open

'?:;f' Run as administrator
Troubleshoot compatibility
Open file location
Pin to Taskbar
Pin to Start Menu

Restare previous versions
Send to

Cut
Copy

Delete

Renarne

Properties

| Search programs and files

5&? FComm Diagnostic
File Diagnose Help

=] | = ©|5|

To be tested

L

Ready

CE-134 Series [COM1-COM4|
IRE=211/0=B400
PCI bus 1, device 10, function 0

Board Status

sekct B (]

Select _'I I

PCl bus 1,
Drriver: 1.2

CB-134 Series [COMT-COM4) -
IRQ=21.1/0=B400

device 100, function 0
4 build 1

Tatal Configuration Boat

COM Part Available Boards = 1

ds=1

NOTE

You can download the PComm Lite software for free from Moxa’s website at

www.moxa.com/support/free downloads.htm.
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Removing the Driver

1. Open the Device Manager and use the mouse to place the cursor over the MOXA CB-134I Series
(PC/104-Plus boards) under Multi-port serial adapters, right-click, and then select the Uninstall option.

=n Device Manager EI@

File  Action  View Help
&= | m|E| Hm| o E %o

4 -5 3pogd2
M Computer

= Disk drives
. B Display adapters

= Floppy disk drives

» = Floppy drive controllers

b :‘!-J Hurman Interface Devices
5 g IDE ATAATAPI contrallers

» 2= Keyhoards

Mice and other painting devices
fonitars

Multi-port serial adapters

AT MOXA CB-1341 Series (PCA104-Plus)
EF Metwork adapters

Other devices

Wy Unknown device Uninstall
Y5 Ports (COM & LPT) -

D Processors

.A--J\ Sound, video and game contrallers
~#ig High Definition Audio Dewvice Properties
| Iysterm devices

-~ § Universal Serial Bus controllers

Update Driver Software..,
Disahble

Scan for hardware changes

Uninstalls the driver for the selected device,

2. Select Delete the driver software for this device and click OK to proceed with uninstalling the board.
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Uninstallating the Driver

The MSB driver may be removed through Add/Remove Programs in the Windows Control Panel. Click Uninstall
next to MOXA Smartio/Industio Windows Driver Verx.xx

EESEE ST
@lem ¥ Control Panel » All Control Panel fems » Programs and Features » Moxa Inc, - | +y ‘ | Sezrch Programs and Featurss pe) |
Control Panel Horme .
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
¥y Turn Windows features on or
=i Organize » Uninstall - [
Marme Uninstall this program. Publisher 4 Installed On  Size Version
= DS Ver2, 1 Petonca Ine, 1/18/2017 L1635 MB
B A0, Srmartio/Industio Windows Driver Verl, 24 Meloca Ine, 143172017 124
@NPDNWindows Driver Manager Maxa Inc, 11872017 119
= PCommm Lite Yerlf Metionca Ine, 14952017 4,52 MEB
4 I +
' | Moxa Inc. Product version: 1.24 Support link: http:/'www.meoxa.com
‘ Help link: http://www.moxa.com Update information: http://www.moxa.com
[all= | =]
@-uvl[‘:[ » Control Panel » &l Control Panel Iterns » Programs and Features » hoxa Inc, - |~51 | | Search Progromms and Fegtures 2 |

Contrel Panel Home .

Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair,
'?_',' Turn Windows features on or

i Organize » Uninstall

>~ O
Name : Publisher ¢ Installed On  Size Version
nDSU Wer2.1 Moza Inc, 1/18/2017 165 ME
= MOXA, SmartiofTndustio Windows Driver Yerl.24 Moz Inc, 173142017 14
@NPDnWindows Driver Manager Moxa Inc, 1/18/2017 113
MOXA Smartio/Industio Windowws Driver Uninstall 2 MR AL

Are you sure you want to completely rermove MOXA Smartio/Tndustio
W¥indows Driver and all of its components?

m
Moxa Inc. Product version: 1.24 Support link: http://www.moxa.com
Help link: http://www.moxa.com  Update information: http://www.moxa.com
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o || & g2
@vvh‘j » Control Panel » All Contral Panel terms » Programs and Features » Maoxa Inc, - | 4,‘ [ Search Prograwms and Fegtures 2|
Control Panel Home .
Uninstall or change a program
View installed updates To uninstall a pregram, select it from the list and then click Uninstall, Change, or Repair.
) Turn Windows features on or
gt Organize = Uninstall ==« [l \9\
Marne ° Publisher & Installed On Size Wersion
= DSU Verz. 1 hooa Inc., 1/18/2017 163 ME
B MOKA Srnartio/Tndustio Windous Driver Verl.24 Moa Inc., 13102017 124
s MPart Wind ows Driver Manager hosea Ine. 1/18/2017 113
MOXA SmartiofIndustio Windows Driver Uninstall @ B SRl
f 4  MOXA Smartio/Industio Windows Driver was successfully remaved
"W from your computer,
< m 3
3|  Moxa Inc. Product version: 1.24 Support link: http:/,
' Help link: http://www.moxa.com Update information: http://www.moxa.com

Non-Windows OS

Linux

1. Execute the following commands from the Linux prompt:

#mount /dev/cdrom /mnt/cdrom

#cd /

#mkdir moxa

#cd moxa

#cp /mnt/cdrom/<driver directory>/mxpcdrv.tgz .

#tar xvfz mxpcdrv.tgz

2. #cd mxpcdrv

# make clean; make install

3. #cd /moxa/mxpcdrv/driver

#./mpmknod

4. Install the module driver using the hardware settings that you selected. For example, for an I/O address of
0x180, an INT vector of 0x1CO0, and an IRQ of 10, execute the following command:
#modprobe mxpcdrv ioaddr=0x180 iovect=0x1CO0 irg=10

(This step is only for CA Series)

5. You can use the Moxa diagnostic utility to verify the driver’s status:
#cd /moxa/mxpcdrv/utility/diag

#./msdiag

6. You can use the Moxa terminal utility to test the TTY ports:

#cd /moxa/mxpcdrv/utility/term

#./msterm
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4

Serial Programming Tools

Moxa provides Windows serial programming libraries and troubleshooting utilities that are easy to use and
powerful. You can use these tools to reduce software development time.

The serial communication library is useful for developing applications for data communications, remote access,
data acquisition, and industrial control. It provides a simpler solution compared to the more complex Windows
Win32 COMM API.

PComm is a professional serial communication tool for Windows PCs. PComm includes the following features:

e Useful utilities for diagnostics, port monitoring, and terminal emulation
e Sample programs
e Comprehensive help files

The following topics are covered in this chapter:

O Serial Programming Library
O PComm Utilities

» Installation

» PComm Diagnostic
» PComm Monitor
>

PComm Terminal Emulator
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Serial Programming Library

The serial programming library assists you in developing serial communications programs for any COM port
that complies with the Microsoft Win32 API. It facilitates the implementation of multi-process and multi-thread
serial communication programs and can remarkably reduce development time.

The library provides a complete set of functions as well as various sample programs for Visual C++, Visual
Basic, and Delphi. To view detailed descriptions of the available functions and sample programs, go to Start 2>
Program = PComm Lite and select PComm Lib Help, PComm Porting Notes, or PComm Programming
Guide. You may also refer to the sample programs in the PComm directory.

PComm Utilities

This sections provides brief descriptions of the PComm utilities. For more information about these utilities,
please refer to the help files or to the API-232.txt file for DOS.

Installation

To install PComm, run Setup.exe from the installation diskette. Please note that the PComm diagnostic and
monitor utilities are for Moxa boards only. These two utilities will not work with other serial boards.

PComm Diagnostic

PComm Diagnostic is designed for Moxa boards only. It provides internal and external testing of IRQ, TxD/RxD,
UART, CTS/RTS, DTR/DSR, DTR/DCD, and other items. You can use PComm Diagnostic to check the operation
of both software and hardware.

To run the Diagnostic program, go to Start & Program - PComm Lite - Diagnostic.

w - JolX])
= | = &5
To be tested... S
“ CA114 Series(4 ports] [COM3-COME) EI . .
| IRO=101/0=1C0 Select [Config) to zet test option

Select __ P | [Go) to start testing

Board Status

CA114 Series(4 portsg] [COM3-COME]
B ro-ovooio
Driver :

Ready

Total Configuration Boards = 1
COM Port Available Boards = 1

_
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PComm Monitor

PComm Monitor is designed for Moxa board in Windows NT only. It allows you to monitor data transmission of
selected Moxa COM ports. It monitors data transmission, throughput, and line status at regular intervals. Click

on a specific port to view that port’s communication parameters and status.

To run PComm Monitor, go to Start & Program = PComm Lite = Monitor.

2+ PComm Monitor

=1ES

Port Count/Tx CP§/Tx Count/Rx CPS/Rx RTS CT3 DTR DSR DCD
coms 126976 1024 125264 1010 @ @ @ @ 0 =
coMa 126376 1024 126976 1024 o @ @ @ @
oS 125352 1015 126760 102z o @ @ @ @
coMe 125952 1015 126300 1018 @ @ @ @ @
com? 125952 1015 126032 1016 @ @ @ @ ©
coms 128000 1032 125828 1014 @ @ @ @ O
126976 125648
oML 126376 1024 125440 1011 o @ @ @ @
comLl 0 0 i i @ @ © @ @
COM3 Port Status © @ @
— Tx [bytesd1g]— [ T+ History : : :
o @ @
© @ @
@ @ @ |
R [bytes/1g]— [~ Fx Histary © & o
| Part Name COM3 | | Port Status Dpen |

Communication Parameter Hewé Flaw Control
eraud Rate [bps) SSE‘ ’7F|TS Flow: Contral ufi}
Diata Bits g CT5 Flove Control oM

PComm Terminal Emulator

)apsed Time:00:02:04

PComm Terminal Emulator can be used to connect to a serial port to verify that data transmission is functioning
correctly. It supports multiple windows and both VT100 and ANSI terminal types. You can interactively transfer
data, periodically send patterns, and transfer files using ASCII, XMODEM, YMODEM, ZMODEM, and KERMIT

protocols.

To run PComm Terminal Emulator, go to Start > Program -> PComm Lite > Terminal Emulator.

£ PComm Terminal - COM44,38400,None.8,1,Dumb Teminal

File  Edit PortManager Pot Window Help

2 B Bl=sE=E S

E*" COM43.9600,Hone.8,1.ANSI

xenix386! login: root

=
'ﬁ Pazsword:
o

Telcome to SC0 XENIX System W

0M44,38400,None.8.1,Dumb Terminal

012345678%abede fuhii0l2345678%ahode fghii012345678%abode fuhi J0123

on have mai [o7R [0 73456785abode fohiJ0123456785ahade fahi 012 34E6789abode fghi 0123

TERM = {ansi [Ty |0123455789abode fghi01Z3456785abode fghi J0128456789abode £ghij 0123
# Le 0123456789abode fghij0123456789abode fohij0123456789abode fghi 0123
'?““le 0122456729abede fghij 012245678 9abode Eghij0123456789abede fghij 0123
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Smartio/Industio Programming Guide

If you want to develop your own driver, no matter whether it is on a Windows or Linux platform, Moxa
Smartio/Industio Programming Guide is very useful.

The following topics are covered in this chapter:

Relative Product List

Resource Requirement for Moxa Board

PCI Configuration for Moxa Board

UART Register Structure for MU860 chip

UART Register Structure for MUE250, MUE450, and MUES850 chips
For Baud Rate Setting

Moxa Board PCI Device ID List

UART Datasheet
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Relative Product List

Please see the “"Moxa Board PCI Device ID List” at the end of this document.

Resource Requirement for Moxa Board

PCI

IRQ * 1
1/0 :
UART register: 64 bytes (8 bytes/port * 8port) for MU860
4096 bytes (512 bytes/port * 8port) for MUE250/450/850

IRQ Vector register:16 bytes (only 1 byte is used)

Configuration for Moxa Board

A. MOXA Vendor ID: 0x1393
B. Device ID: Please see the “Moxa Board PCI Device ID List” section

C. Hardware resources on the Device Configuration Register of the PCI configuration space:

Resource Name Chip Address Offset Size
IRQ All 0x3C

IRQ Vector Address MU860 0x1C BAR3 16 bytes
UART register MU860 0x18 BAR2 64 bytes
(I/O Base Address)

UART register MUE250, MUE450, MUE850 |0x14 BAR1 4096 bytes
(Memory Base Address)

Vector Base Address MUE250, MUE450, MUE850 |0x18 BAR2 16 bytes
Byte 0-7 8-15 16-23 24-31

Offset

00h Vendor ID Device ID

04h Command Status

08h

0Ch

10h BARO

14h BAR1

18h BAR2

1Ch BAR3

3Ch Interrupt Line Interrupt Pin Reserved

NOTE

For MUE250, MUE450, and MUE850 chips only:
Memory mode is recommended for these chips to access UART. To use memory mode, the driver has to access
the memory base address, which is located at BAR1.
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UART Register Structure for MU860 chip

——————  Total64 bytes  —
[[Bbwtes] Sbwes| .. | |
lstportz  Znd ports ath port's
ULRT UART .. TART
register Tegister e gister
TART repgister, 8 botes for each port
[ Thote] 1 bote | [ - [ |

lst 2nd. Ath

e pister, Tegister, i

RER/THR  [ER SR

NOTE For a detailed UART register description, please see the "UART Datasheet” section..

o UART register address = I/0 base address + (port-1) *8
For example, if the base address is 0x180:

The first port’s UART registered I/0 address is 0x180+(1-1)*8 = 0x180
The first registered I/0 address is 0x180,
The second registered I/0 address is 0x181,

The second port’s UART registered I/0O address is 0x180+(2-1)*8 = 0x188

The first registered I/0 address is 0x188,
The second registered I/0 address is 0x189, ...

° IRQ Vector Register Structure

I Toul1bye(@bit) |

[ 1bit | Ibit | | 1bit |
bif?: 8th port bt 7th port bafl) - 1th port
Bit Value Status
0 Interrupt pending. Please read the UART register to get the detail interrupt
information *.
1 No interrupt pending.

All serial ports on the same Moxa board use the same IRQ. Check the vector to determine which port issues the
interruption. You can also get the information by querying the IIR of each port.
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UART Register Structure for MUE250, MUE450,
and MUE850 chips

There are 512 bytes for each UART register and 0x200 offset between each port. However, there is one
exception, for the models which are 4-port boards, such as CP-104EL-A, CP-114EL, CP-114EL-I, and
CP-134EL-A, the offset of the fourth UART register is 0xEQO.

UART Register Offset —555

UARTO Registers

02000
UART1 Registers

04000 |
UARTZ2 Registers

0600
UART3 Registers

0800h UART Register Offset

i 0000h
R UART4 Registers UARTO Registers
0ADOR | ] T
_| UARTS Registers UART1 Registers
0cooh . 04001
UARTS Registers UARTZ Registers
0EOOh =T
UARTY Registers UART3 Registers
Registers for 8 ports Registers for 4 ports

NOTE For a detailed UART register description, please see the "UART Datasheet” section..

o UART register address = I/0 base address + (port-1) * 0x200
For example, if base address is 0x200:

The first port’s UART registered I/0 address is 0x200 + (1-1) * 0x200 = 0x200
.................. The first registered I/O address is 0x200,
The second registered I/0O address is 0x201, .....

The second port’s UART registered I/0 address is 0x200 + (2-1) * 0x200 = 0x400

The first registered 1/0 register is 0x400,
The second registered I/0 register is 0x401, .....

NOTE For CP-104EL-A, CP-114EL, CP-114EL-I, and CP-134EL-A only:
The first port's UART registered address: I/O base address
The second port’s UART registered address: I/O base address + 1 * 0x200
The third port’s UART registered address: I/O base address + 2 * 0x200
The fourth port’s UART registered address:I/O base address + 7 * 0x200Type note content here.
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° Control Serial Interface and Termination Resistor for MUE chips

For Moxa boards that use MUE250, MUE450, and MUE850 chips, BAR2, which is allocated 16 bytes. is the
vector base address that can be used to control the serial interface and termination resistor according to
the following table.

Offset Bit Port # Parameters
0x4 [3..0] 1 0x0 : RS-232
[7..4] 2 0x1 : RS-422
0x5 [3..0] 3 OxF : RS-485 2W
[7..4] 4 0xB : RS-485 4W
0x6 [3..0] 5
[7..4] 6
0x7 [3..0] 7
[7..4] 8
0x8 [7..0] [8..1] GPIO - Input
0x9 [7..0] [8..1] GPIO direction configuration
0 : Set GPIO direction to input
1 : Set GPIO direction to output
OxA [7..0] [8..1] GPIO - Output (Termination Resistor)
0 : Low (0 Ohm)
1 : High (120 Ohm)

Especially, the interface of 4-port models, such as CP-114EL and CP-114EL-I, is using the following offset to set
the interface of port 4.

Offset Bit Port # Parameters
0x4 [3..0] 1 0x0 : RS-232
[7..4] 2 0x1 : RS-422
0x5 [3..0] 3 OxF : RS-485 2W
[7..4] - 0OxB : RS-485 4w
0x6 [3..0] -
[7..4] -
0x7 [3..0] 4

For Baud Rate Setting

For General PC Com Port: CLK=1.8432MHz

Div = CLK/(Baud x 16)

But for Moxa Board: CLK=14.7456MHz

Div = CLK/(Baud x 16)
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Moxa Board PCI Device ID List

Model Ports Bus Chip Max Baud Vendor ID |Device ID
CP-102U 2 UPCI MU860 921.6k 0x1393 0x1022
CP-102UL 2 UPCI MU860 921.6k 0x1393 0x1021
CP-132UL 2 UPCI MU860 921.6k 0x1393 0x1321
CP-132UL-I 2 UPCI MU860 921.6k 0x1393 0x1321
CP-102E 2 PCIe MUE250 921.6k 0x1393 0x1024
CP-102EL 2 PClIe MUE250 921.6k 0x1393 0x1025
CP-132EL 2 PClIe MUE250 921.6k 0x1393 0x1322
CP-132EL-I 2 PClIe MUE250 921.6k 0x1393 0x1322
CP-104UL 4 UPCI MU860 921.6k 0x1393 0x1041
CP-104JU 4 UPCI MU860 921.6k 0x1393 0x1042
CP-114UL 4 UPCI MU860 921.6k 0x1393 0x1143
CP-114UL-I 4 UPCI MU860 921.6k 0x1393 0x1143
CP-134U 4 UPCI MU860 921.6k 0x1393 0x1340
CP-134U-1 4 UPCI MU860 921.6k 0x1393 0x1340
CP-104EL-A 4 PCIe MUE450 921.6k 0x1393 0x1045
CP-114EL 4 PCIe MUE450 921.6k 0x1393 0x1144
CP-114EL-I 4 PCIe MUE450 921.6k 0x1393 0x1144
CP-134EL-A 4 PClIe MUE450 921.6k 0x1393 0x1342
CB-114 4 PC/104-Plus MU860 921.6k 0x1393 0x1142
CB-1341 4 PC/104-Plus MU860 921.6k 0x1393 0x1341
CP-118U 8 UPCI MU860 921.6k 0x1393 0x1180
CP-118U-I 8 UPCI MU860 921.6k 0x1393 0x1180
CP-138U 8 UPCI MU860 921.6k 0x1393 0x1380
CP-138U-1 8 UPCI MU860 921.6k 0x1393 0x1380
CP-168U 8 UPCI MU860 921.6k 0x1393 0x1681
CP-116E-A(A) 8 PCIe MUES850 921.6k 0x1393 0x1160
CP-116E-A(B) 8 PCIe MUES850 921.6k 0x1393 Ox1161
CP-118EL-A 8 PCIe MUES850 921.6k 0x1393 0x1182
CP-118E-A-I 8 PCIe MUES850 921.6k 0x1393 0x1183
CP-138E-A-I 8 PCIe MUE850 921.6k 0x1393 0x1381
CP-168EL-A 8 PCle MUES850 921.6k 0x1393 0x1683
CB-108 8 PC/104-Plus MU860 921.6k 0x1393 0x1080

UART Datasheet

Moxa'’s chips are compatible with the following chips. For more details about the UART register description,
please refer to the downloaded links below.

UART Port Datasheet
MU-860 2-8 TL16C550C
MUE-250 2 PI7C9X7952
MUE-450 4 PI7C9X7954
MUE-850 8 PI7C9X7958
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Pin Assignments

The box header connector(s) on the module is used to connect to serial devices. Optional cables are available
that provide DB9 or DB25 connectors. The pin assignments of the box header connectors and available cables
are provided below.

Box Header Pin Assignments

RS-232

These pin assignments apply to the CA-108/CB-108, CA-114/CB114, and CA-104. Note that there are two
40-pin box header connectors on the CA-108/CB108, each of which connects to 4 serial ports.

Pin Signal Pin Signal Pin Signal Pin Signal
1 DCDO 11 DCD1 21 DCD2 31 DCD3
2 DSRO 12 DSR1 22 DSR2 32 DSR3
3 RxDO 13 RxD1 23 RxD2 33 RxD3
4 RTSO 14 RTS1 24 RTS2 34 RTS3
5 TxDO 15 TxD1 25 TxD2 35 TxD3
6 CTSO 16 CTS1 26 CTS2 36 CTS3
7 DTRO 17 DTR1 27 DTR2 37 DTR3
8 --- 18 --- 28 --- 38 ---
9 GNDO 19 GND1 29 GND2 39 GND3
10 --- 20 --- 30 --- 40 ---

RS-422, 4-wire RS-485

These pin assignments apply to the CA-132, CA-132I, CA-114/CB-114, and CA-1341/CB1341. With regard to

the CA Series, pins 21 to 40 apply to the CA-114 and CA-134I only.

Pin Signal Pin Signal Pin* Signal* Pin* Signal*
1 TxDO-(A) 11 TxD1-(A) 21 TxD2-(A) 31 TxD3-(A)
3 TxD0+(B) 13 TxD1+(B) 23 TxD2+(B) 33 TxD3+(B)
5 RxDO+(B) 15 RxD1+(B) 25 RxD2+(B) 35 RxD3+(B)
7 RxDO0-(A) 17 RxD1-(A) 27 RxD2-(A) 37 RxD3-(A)
9 GNDO 19 GND1 29 GND2 39 GND3




Pin Assignments

CA Series PC/104

2-wire RS-485
These pin assignments apply to the CA-132 , CA-1321, CA-114/CB-114, and CA-1341/CB-1341. With regard to
the CA series, pins 21 to 40 apply to the CA-114 and CA-134I only.

Pin Signal Pin Signal Pin* Signal* Pin* Signal*
5 Data0+(B) 15 Datal+(B) 25 Data2+(B) 35 Data3+(B)
Data0-(A) 17 Datal-(A) 27 Data2-(A) 37 Data3-(A)

GNDO 19 GND1 29 GND2 39 GND3
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